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Important safety information
This manual contains information and warnings that must be followed by the user for safe operation and to keep the product in a safe
condition.

To safely perform service on this product, see the Service safety summary that follows the General safety summary.

General safety summary
Use the product only as specified. Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it. Carefully read all instructions. Retain these instructions for future reference.

This product shall be used in accordance with local and national codes.

For correct and safe operation of the product, it is essential that you follow generally accepted safety procedures in addition to the safety
precautions specified in this manual.

The product is designed to be used by trained personnel only.

Only qualified personnel who are aware of the hazards involved should remove the cover for repair, maintenance, or adjustment.

Before use, always check the product with a known source to be sure it is operating correctly.

This product is not intended for detection of hazardous voltages.

Use personal protective equipment to prevent shock and arc blast injury where hazardous live conductors are exposed.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other component manuals
for warnings and cautions related to operating the system.

When incorporating this equipment into a system, the safety of that system is the responsibility of the assembler of the system.

To avoid fire or personal injury

Use proper power cord
Use only the power cord specified for this product and certified for the country of use. Do not use the provided power cord for other
products.

Ground the product
This product is grounded through the grounding conductor of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output terminals of the product, ensure that the product is properly
grounded. Do not disable the power cord grounding connection.

Power disconnect
The power cord disconnects the product from the power source. See instructions for the location. Do not position the equipment so that it is
difficult to operate the power cord; it must remain accessible to the user at all times to allow for quick disconnection if needed.

Connect and disconnect properly
Do not connect or disconnect probes or test leads while they are connected to a voltage source.

Use only insulated voltage probes, test leads, and adapters supplied with the product, or indicated by Tektronix to be suitable for the
product.

Important safety information
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Observe all terminal ratings
To avoid fire or shock hazard, observe all rating and markings on the product. Consult the product manual for further ratings information
before making connections to the product.

Do not exceed the Measurement Category (CAT) rating and voltage or current rating of the lowest rated individual component of a product,
probe, or accessory. Use caution when using 1:1 test leads because the probe tip voltage is directly transmitted to the product.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum rating of that terminal.

Do not float the common terminal above the rated voltage for that terminal.

The measuring terminals on this product are not rated for connection to mains or Category II, III, or IV circuits.

Do not operate without covers
Do not operate this product with covers or panels removed, or with the case open. Hazardous voltage exposure is possible.

Avoid exposed circuitry
Do not touch exposed connections and components when power is present.

Do not operate with suspected failures
If you suspect that there is damage to this product, have it inspected by qualified service personnel.

Disable the product if it is damaged. Do not use the product if it is damaged or operates incorrectly. If in doubt about safety of the product,
turn it off and disconnect the power cord. Clearly mark the product to prevent its further operation.

Before use, inspect voltage probes, test leads, and accessories for mechanical damage and replace when damaged. Do not use probes or
test leads if they are damaged, if there is exposed metal, or if a wear indicator shows.

Examine the exterior of the product before you use it. Look for cracks or missing pieces.

Use only specified replacement parts.

Do not operate in wet/damp conditions
Be aware that condensation may occur if a unit is moved from a cold to a warm environment.

Do not operate in an explosive atmosphere

Keep product surfaces clean and dry
Remove the input signals before you clean the product.

Provide proper ventilation
Refer to the installation instructions in the manual for details on installing the product so it has proper ventilation.

Slots and openings are provided for ventilation and should never be covered or otherwise obstructed. Do not push objects into any of the
openings.

Provide a safe working environment
Always place the product in a location convenient for viewing the display and indicators.

Avoid improper or prolonged use of keyboards, pointers, and button pads. Improper or prolonged keyboard or pointer use may result in
serious injury.

Be sure your work area meets applicable ergonomic standards. Consult with an ergonomics professional to avoid stress injuries.

Important safety information
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Use care when lifting and carrying the product. This product is provided with a handle or handles for lifting and carrying.

WARNING: The product is heavy. To reduce the risk of personal injury or damage to the device get help when lifting or carrying
the product.

Use only the Tektronix rackmount hardware specified for this product.

Probes and test leads
Before connecting probes or test leads, connect the power cord from the power connector to a properly grounded power outlet.

Keep fingers behind the protective barrier, protective finger guard, or tactile indicator on the probes. Remove all probes, test leads and
accessories that are not in use.

Use only correct Measurement Category (CAT), voltage, temperature, altitude, and amperage rated probes, test leads, and adapters for
any measurement.

Beware of high voltages
Understand the voltage ratings for the probe you are using and do not exceed those ratings. Two ratings are important to know and
understand:

• The maximum measurement voltage from the probe tip to the probe reference lead.
• The maximum floating voltage from the probe reference lead to earth ground.

These two voltage ratings depend on the probe and your application. Refer to the Specifications section of the manual for more
information.

WARNING: To prevent electrical shock, do not exceed the maximum measurement or maximum floating voltage for the
oscilloscope input BNC connector, probe tip, or probe reference lead.

Connect and disconnect properly
Connect the probe output to the measurement product before connecting the probe to the circuit under test. Connect the probe reference
lead to the circuit under test before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement product.

Connect the probe reference lead to earth ground only.

Inspect the probe and accessories
Before each use, inspect probe and accessories for damage (cuts, tears, or defects in the probe body, accessories, or cable jacket). Do
not use if damaged.

Ground-referenced oscilloscope use
Do not float the reference lead of this probe when using with ground-referenced oscilloscopes. The reference lead must be connected to
earth potential (0 V).

Floating measurement use
Do not float the reference lead of this probe above the rated float voltage.

Important safety information
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Service safety summary
The Service safety summary section contains additional information required to safely perform service on the product. Only qualified
personnel should perform service procedures. Read this Service safety summary and the General safety summary before performing any
service procedures.

To avoid electric shock
Do not touch exposed connections.

Do not service alone
Do not perform internal service or adjustments of this product unless another person capable of rendering first aid and resuscitation is
present.

Disconnect power
To avoid electric shock, switch off the product power and disconnect the power cord from the mains power before removing any covers or
panels, or opening the case for servicing.

Use care when servicing with power on
Dangerous voltages or currents may exist in this product. Disconnect power, remove battery (if applicable), and disconnect test leads
before removing protective panels, soldering, or replacing components.

Verify safety after repair
Always recheck ground continuity and mains dielectric strength after performing a repair.

Terms in this manual
These terms may appear in this manual:

WARNING: Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION: Caution statements identify conditions or practices that could result in damage to this product or other property.

Terms on the product
These terms may appear on the product:

• DANGER indicates an injury hazard immediately accessible as you read the marking.
• WARNING indicates an injury hazard not immediately accessible as you read the marking.
• CAUTION indicates a hazard to property including the product.

Symbols on the product
When this symbol is marked on the product, be sure to consult the manual to find out the nature of the potential
hazards and any actions which have to be taken to avoid them. (This symbol may also be used to refer the user to
ratings in the manual.)

Important safety information
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The following symbols(s) may appear on the product.

CAUTION: Refer to
Manual

Protective Ground (Earth)
Terminal

Earth Terminal Chassis Ground Standby

Important safety information
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Compliance information
This section lists the safety and environmental standards with which the instrument complies. This product is intended for use by
professionals and trained personnel only; it is not designed for use in households or by children.

Compliance questions may be directed to the following address:

Tektronix, Inc.
PO Box 500, MS 19-045
Beaverton, OR 97077, US
tek.com

Safety compliance
This section lists the safety standards with which the product complies and other safety compliance information.

EU declaration of conformity – low voltage
Compliance was demonstrated to the following specification as listed in the Official Journal of the European Union:

Low Voltage Directive 2014/35/EU.

• EN 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General
Requirements

• EN 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 2-030: Particular
requirements for testing and measuring circuits

U.S. nationally recognized testing laboratory listing
• UL 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements
• UL 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 2-030: Particular

requirements for testing and measuring circuits

Canadian certification
• CAN/CSA-C22.2 No. 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1:

General Requirements
• CAN/CSA-C22.2 No. 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use –

Part 2-030: Particular requirements for testing and measuring circuits

Additional compliances
• IEC 61010-1. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 1: General

Requirements
• IEC 61010-2-030. Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use – Part 2-030:

Particular requirements for testing and measuring circuits

Equipment type
Test and measuring equipment.

Safety class
Class 1 – grounded product.

Compliance information
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Pollution degree description
A measure of the contaminants that could occur in the environment around and within a product. Typically the internal environment inside a
product is considered to be the same as the external. Products should be used only in the environment for which they are rated.

• Pollution Degree 1. No pollution or only dry, nonconductive pollution occurs. Products in this category are generally encapsulated,
hermetically sealed, or located in clean rooms.

• Pollution Degree 2. Normally only dry, nonconductive pollution occurs. Occasionally a temporary conductivity that is caused by
condensation must be expected. This location is a typical office/home environment. Temporary condensation occurs only when the
product is out of service.

• Pollution Degree 3. Conductive pollution, or dry, nonconductive pollution that becomes conductive due to condensation. These are
sheltered locations where neither temperature nor humidity is controlled. The area is protected from direct sunshine, rain, or direct
wind.

• Pollution Degree 4. Pollution that generates persistent conductivity through conductive dust, rain, or snow. Typical outdoor locations.

Pollution degree rating
Pollution Degree 2 (as defined in IEC 61010-1). Note: Rated for indoor, dry location use only.

IP rating
IP20 (as defined in IEC 60529).

Measurement and overvoltage category descriptions
Measurement terminals on this product may be rated for measuring mains voltages from one or more of the following categories (see
specific ratings marked on the product and in the manual).

• Overvoltage Category I. For equipment intended to be connected to a mains supply in which means have been taken to substantially
and reliably reduce transient overvoltages to a level where they cannot cause a hazard.

• Measurement Category II. For measurements performed on circuits directly connected to the low-voltage installation.
• Measurement Category III. For measurements performed in the building installation.
• Measurement Category IV. For measurements performed at the source of low-voltage installation.

Note: Only mains power supply circuits have an overvoltage category rating. Only measurement circuits have a measurement
category rating. Other circuits within the product do not have either rating.

Mains overvoltage category rating
Overvoltage Category II (as defined in IEC 61010-1)

Environmental compliance
This section provides information about the environmental impact of the product.

Restriction of hazardous substances
Complies with RoHS2 Directive 2011/65/EU.

Product end-of-life handling
Observe the following guidelines when recycling an instrument or component:

Equipment recycling Production of this equipment required the extraction and use of natural resources. The equipment may
contain substances that could be harmful to the environment or human health if improperly handled at the

Compliance information
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product’s end of life. To avoid release of such substances into the environment and to reduce the use of
natural resources, we encourage you to recycle this product in an appropriate system that will ensure that
most of the materials are reused or recycled appropriately.

This symbol indicates that this product complies with the applicable European Union requirements according to
Directives 2012/19/EU and 2006/66/EC on waste electrical and electronic equipment (WEEE) and batteries. For
information about recycling options, check the Tektronix Web site (www.tek.com/productrecycling).

Battery recycling This product contains a small installed lithium metal button cell. Please properly dispose of or recycle the
cell at its end of life according to local government regulations.

Perchlorate materials This product contains one or more type CR lithium batteries. According to the state of California, CR
lithium batteries are classified as perchlorate materials and require special handling. See www.dtsc.ca.gov/
hazardouswaste/perchlorate for additional information.

Transporting batteries
The small lithium primary button cell contained in this equipment does not exceed 1 gram of lithium metal content per cell.

The cell type has been shown by the manufacturer to comply with the applicable requirements of the UN Manual of Tests and Criteria
Part III, Sub-section 38.3. Consult your carrier to determine which lithium battery transportation requirements are applicable to your
configuration, including to its re-packaging and re-labeling, prior to reshipment of the product by any mode of transport.

Compliance information
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Preface
This manual provides product safety and compliance information, describes how to connect and power on the oscilloscope, and introduces
the instrument features, controls and basic operations. See the product Help file for more detailed information.

Key features
Welcome to the 5 Series MSO Low Profile. The 5 Series MSO Low Profile (MSO58LP) is an 8-channel oscilloscope with the world's first
FlexChannel®-based inputs, enabling you to efficiently and cost-effectively perform mixed signal debugging on virtually any design.

• Low profile instrument with no display, comes ready to install in a 2U rack mount space
• 500 MHz (upgradeable) and 1 GHz bandwidths
• 8 channels with FlexChannel® inputs
• Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital probe

(the TLP058 FlexChannel Logic Probe)
• Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog and spectral

view of the same channel at the same time with independent controls for each view
• Maximum 6.25 GS/s sample rate
• 125 M points record length on all channels (optional 250, 500 M record length available)
• 500,000 waveforms/second maximum waveform capture rate
• Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)
• Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for

each channel
• FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample

rates while conserving acquisition memory
• No set limit on the number of math, reference, and bus waveforms you can acquire (the number of waveforms depends on available

system memory)
• Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter
• Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and

trigger options Help topic
• Power, WBG-DPT, Spectrum measurements, DPM, IMDA, and Jitter options provide additional measurement and analysis functions.

See the Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics.

Check shipped accessories
Make sure that you received everything you ordered. If anything is missing, visit tek.com/contact-tek to find contacts in your area.

Check the packing list that came with your instrument to verify that you have received all standard accessories and ordered items. If you
purchased factory installed options, tap Help > About to confirm that the option(s) are listed in the Installed Options table.

Item Quantity Tektronix part number
5 Series MSO MSO58LP Installation and Safety Manual 1 071-3568-xx
Power cord 1 Depends on region
Calibration certificate 1 N/A
Report of factory installed licenses 1 N/A

Preface
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Documentation
Review the following user documents before installing and using your instrument. These documents provide important operating
information.

Product documentation
The following table lists the primary product specific documentation available for your product. These and other user documents are
available for download from tek.com. Other information, such as demonstration guides, technical briefs, and application notes, can also be
found at tek.com.

Document Content
Installation and Safety Instructions Safety, compliance, and basic introductory information for hardware

products.
Help In-depth operating information for the product. Available from the

Help button in the product UI and as a downloadable PDF on
www.tek.com/downloads.

Quick Start User Manual Introduction to product hardware and software, installation
instructions, turn on, and basic operating information.

Specifications and Performance Verification Technical Reference Instrument specifications and performance verification instructions
for testing instrument performance.

Programmer Manual Commands for remotely controlling the instrument.
Declassification and Security Instructions Information about the location of memory in the instrument.

Instructions for declassifying and sanitizing the instrument.
Service Manual Replaceable parts list, theory of operations, and repair and replace

procedures for servicing an instrument.

How to find your product documentation
1. Go to tek.com.
2. Click Download in the green sidebar on the right side of the screen.
3. Select Manuals as the Download Type, enter your product model, and click Search.
4. View and download your product manuals. You can also click the Product Support Center and Learning Center links on the page for

more documentation.

Operating requirements
Use the instrument within the required operating temperature, power, altitude, and signal input voltage ranges to provide the most accurate
measurements and safe instrument operation.

Environment requirements
Characteristic Description
Operating temperature 0 °C to +50 °C (+32 °F to +122 °F). For proper cooling, keep the sides of the instrument clear of

obstructions for 2 inches (51 mm).
Operating humidity 5% to 90% relative humidity (% RH) up to +40 °C (+104 °F), non-condensing

5% to 55% RH above +40 °C up to +50 °C (+104 °F to +122 °F), non-condensing
Operating altitude Up to 3000 meters (9842 feet)

Preface
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Power requirements
Characteristic Description
Power source voltage 100 V - 240 VAC RMS, ±10%, single phase

Power source frequency 50/60 Hz, 100-240 V
400 Hz, 115 V

Power consumption 400 W maximum

Input signal requirements
Keep the input signals within allowed limits to ensure the most accurate measurements and prevent damage to the analog and digital
probes or instrument.

Make sure that input signals connected to the MSO instrument are within the following requirements.

Input Description
Analog input channels, 1 MΩ setting,
maximum input voltage at BNC

300 VRMS

Measurement Category II
Analog input channels, 50 Ω setting,
maximum input voltage at BNC

5 VRMS

Digital input channels, maximum input
voltage range at digital inputs

Observe probe ratings: TLP058; ±42 VP

Ref In maximum input voltage at BNC (rear
panel)

7 VPP

Aux In trigger input ±5 VRMS

Installing the instrument in a rack
Use these instructions to install the Low Profile instrument into a standard 19" wide by 24" to 32" deep equipment rack.

The instrument comes equipped with the rack bracket hardware installed on the chassis. Use the bolts and washers from the bag that
ships with the instrument to install the rear rack brackets in the rack.

To use an Low Profile instrument on a bench, purchase and install the MSO58LP/LPD64 Benchtop Conversion kit (Tektronix part number
020-3180-xx). The kit includes chassis feet and a handle, and lets you stack instruments on a bench.

Follow these steps to install the instrument in a rack:

WARNING: To prevent injury, two people are required to install the instrument.

1. Use two bolts and washers from the supplied hardware to attach one of the rear rack brackets to the rear of the rack. Tighten by hand.

Preface
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2. Using two people to support the instrument, insert the instrument from the front of the rack so that the chassis rack bracket inserts into
the rear rack bracket.

3. Continue pushing from the front until the instrument is flush with the front of the rack.
4. Use four bolts and washers from the supplied hardware to attach the front of the instrument to the rack. Tighten by hand to support the

instrument.
5. From the rear of the rack, slide the second rear rack bracket onto the instrument chassis rack bracket until the rear rack bracket is flush

with the rear rack.
6. Use two bolts and washers from the supplied hardware to attach the second rear rack bracket to the rear of the rack. Tighten by hand.
7. Tighten all bolts to 1.1 N·m.
8. Using a 5/16 inch wrench, attach two supplied hexhead bolts to the rack bracket assembly on each side, to lock the brackets in place

and prevent the instrument from unintentional removal when the front rack screws are removed (see the following image). There are
four bolt positions available on each side (see image). Tighten the bracket lock bolts to 0.7 N·m.

9. Attach power cord and cables to rear chassis as needed.

End of rack mount instructions.

Secure (lock) the instrument
Lock an instrument to a test bench or equipment rack to prevent property loss.

To secure the instrument to a workbench, rack, or other location, attach a standard laptop security lock to the rear panel of the instrument.

Preface
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Powering the instrument
Use this procedure to connect the instrument to line power and power on and off the instrument. Always connect the instrument to AC
power using the power cord that shipped with the instrument.

Before you begin
Use the AC power cord that shipped with your instrument.

Procedure
1. Connect the supplied power cord to the instrument power connector on the back of the instrument.

Figure 1: MSO58LP power cord connector and power standby switch

2. Connect the power cord to an appropriate AC mains source.
Power is supplied to the power supply and some other boards whenever the AC power cord is connected to a live mains circuit, putting
the instrument in standby mode.

3. Push the front panel power button to power the instrument on and off.
The power button color indicates instrument power states:

• Unlit – no AC power applied
• Yellow – standby mode
• Blue – powered on

4. To completely remove power from the instrument, disconnect the power cord.

Check that the instrument passes power-on self tests
Power-on self tests verify that all instrument modules are working correctly after power up.

Before you begin
For the Low Profile instruments, connect a monitor to a video output on the rear panel and connect a mouse to a USB port.

Procedure
1. Power on the instrument and wait until the instrument screen appears on the monitor.
2. Select Utility > Self Test from the top-edge Menu bar to open the Self Test configuration menu.
3. Check that the status of all power-on self tests are Passed.

If one or more power-on self tests shows Failed:
a) Power cycle the instrument.
b) Tap Utility > Self Test. If one or more power-on self tests still shows Failed, contact Tektronix Customer Support.

Preface
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Connecting probes to the instrument
Probes connect the instrument to your device under test (DUT). Use a probe that best matches your signal measurement needs.

Figure 2: Connecting probes to the MSO58LP

Connecting Probes
Connect TPP Series, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into a FlexChannel connector. The
probe base latch locks with a 'click' when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If a probe
has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active probes to set their
parameters (auto zero, degauss, and so on).

To connect a TLP058 FlexChannel Logic Probe or a TDP7700 Series TriMode™ Probe:

1. Move the locking lever to the unlocked position, then let go to reset locking lever to the center position.
2. Insert the probe into a FlexChannel connector until fully seated and the lock mechanism clicks.
3. Move the locking lever to the locked position. The status light should be a solid green.
4. To disconnect the TLP058 probe, move and hold the locking lever at the unlocked position and pull out the probe. Do not pull on the

ribbon cable while removing the probe.

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until it locks.

Note: Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Preface
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Getting acquainted with your instrument
The following content provides a high-level description of the instrument controls and user interface. Refer to the instrument help for
detailed information on using the controls and user interface to display waveforms and take measurements.

Front panel controls and connections
Use the front panel is to power on or off the instrument, connect signals with probes or cables, connect an auxiliary trigger input signal, and
insert USB devices.

The MSO58LP front panel

1. FlexChannel® probe connectors: FlexChannel® connectors support all TekVPI+ and TekVPI measurement probes, BNC passive
probes, the TLP058 FlexChannel® Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector
until the probe seats with a click. See Connecting probes to the instrument on page 20

2. LAN Status LED: Shows the network connection and activity status:

• Off - No power to instrument
• Green - Network connection is good
• Red - Network connection has fault or is not connected

3. Probe Compensation connectors:
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The Probe Compensation connections provide a ground connector and 1 kHz square wave source for adjusting the high-frequency
response of a passive probe (probe compensation). The oscilloscope uses this signal to automatically compensate supported probes.
See Compensate the TPP Series probes on page 42.

You can also use the ground connector to attach an anti-static wrist strap, to reduce the chance of electrostatic damage (ESD) while
you handle or probe the DUT.

4. USB Host ports: USB ports are located at the lower right corner of the front panel. Connect USB flash drives to which you can save or
recall data (such as instrument firmware updates, waveforms, settings, and screen captures), or connect peripheral devices such as a
mouse or keyboard.

5. Aux Trig trigger input connector: An SMA connector to which you can connect an external trigger input signal. Use the AUX In
trigger signal with the Edge trigger mode.

6. Acq status LED: Shows the instrument trigger/acquisition status:

• Green - Triggered
• Yellow - Armed but not yet triggered
• Red - Acquisition stopped

7. Power On/Standby button: Powers the instrument on and off. The power button color indicates instrument power states:

• No light - No AC power applied
• Yellow - Standby mode
• Blue - Powered on

Getting acquainted with your instrument

22



Rear panel connections
The rear panel connections supply power to the instrument and provide connectors for network, USB devices, video, reference signals,
and the AFG output.

1. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.
3. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization signal from

the AFG.
4. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.
5. Video outputs (Display Port, VGA, and DVI-D) let you connect an external monitor or projector to show the instrument's graphical user

interface.
6. USB 3.0 Device port lets you connect to a PC to remotely control the instrument using USBTMC protocol.
7. USB Host ports let you connect a USB memory device, keyboard, or mouse.
8. LAN connector (RJ-45) connects the instrument to a 10/100/1000 Base-T local area network.
9. Security lock connector lets you use a standard PC/laptop lock cable to secure the instrument to a work bench or other location.

The graphical user interface
Although designed for programmatic control, the MSO58LP also has a graphical user interface that incorporates product Help topics.
You can access the graphical interface by connecting a monitor and mouse to the instrument, or by using a browser to access a
network-connected instrument.

Connect a monitor (standard or touchscreen) with a maximum resolution of 1,920 horizontal × 1,080 vertical pixels (High Definition) to a
video out connector on the rear panel.

To access from a browser, type the IP address of the instrument in the browser address field to open the instrument's browser welcome
page. Click the Instrument Control (e*Scope®) link on the left of the screen to open the graphical interface.

Connect a mouse (USB cable) or mouse dongle (for USB wireless mouse) to any USB port.

You can also get information by opening the instrument Help system. Select Help > Help in the Menu bar.
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User interface screen
The touch screen user interface contains waveforms and plots, measurement readouts, and touch-based controls to access all
oscilloscope functions.

1. The Menu bar provides menus for typical operations including:

• Saving, loading, and accessing files
• Undoing or redoing an action
• Setting oscilloscope display and measurement preferences
• Configuring network access
• Running self tests
• Erasing measurement and settings memory (TekSecure™)
• Loading option licenses
• Opening a Help viewer

2. The Waveform View area displays analog, digital, math, reference, bus, and trend waveforms. The waveforms include waveform
handles (identifiers), individual vertical graticule scale labels, and trigger position and level(s) indicators. You can set the Waveform
View to stack each waveform vertically in separate graticules, called 'slices' (the default mode, as shown in the previous image), or
overlay all the waveforms on the screen (traditional waveform view). See User interface elements on page 26.

You can also add Histogram, Spectral, Eye, and Measurement Results views (plots) for individual measurements. These plot views are
separate view windows that you can move on the screen by dragging their title bar to a new position.

3. The Results Bar contains controls for displaying cursors, adding callout, plots, and result tables to the screen, and add measurements
to the Results bar. To remove a measurement, search or other badge from the Results Bar simply flick it off screen. The controls are:

• The Cursors button displays on-screen cursors in the selected view. Touch and drag, or use the Multipurpose knobs, to move the
cursors. Double-tap on a cursor, or on the cursor readouts, to open a configuration menu to set cursor types and related functions.

• The Measure button opens a configuration menu from which to select and add measurements to the Results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.
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• The Results Table button adds a Measurement or Bus Results table to the screen. The Measurement Results table displays all
measurements present in the Results bar. The Bus Results table displays bus decode information for displayed bus waveforms.
Each table is contained within its own view window, which can be moved within the display area.

• To remove a measurement, search or other badge from the Results Bar simply flick it off screen.
• The Callout button adds a Callout object to the selected view. Double-tap the Callout text to open a configuration menu to change

the type of callout, text and font characteristics. Drag any callout other than bookmark to any location on the oscilloscope screen
view. Bookmarks callout can only be added to waveviews and spectrum views.

• The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search configuration
menu and set the search conditions for analog and digital channels. You can add any number of searches to the same waveform or
to different waveforms. Search badges are added to the Results Bar.

• The Plot button adds an XY, XYZ, or Eye Diagram plot to the display. These plots are contained within their own window and can
be moved within the overall display area.

• The Measurement and Search badges show measurement and search results, and are displayed in the Results Bar. See
Badges on page 28. See Add a measurement on page 51. See Add a Search on page 55.

• The Zoom icon button at the up right of the Results Bar lets you to draw a box on the screen to zoom in on an area of interest,
drawing segments for mask testing, or drawing areas to define visual trigger conditions.

• The More... button at the up right of the Results Bar allows you to select Zoom, Visual trigger, Mask, or Waveform Histogram.
4. The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive Channel

buttons to turn on channels; Add New Waveform buttons to add math, reference, and bus waveforms to the display; and Channel and
Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform button to add it to the screen
and display a badge. Double-tap a badge to open its configuration menu. See Badges on page 28.

5. Configuration Menus let you quickly change the parameters of the selected user interface item. You can open configuration menus by
double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 37.
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User interface elements
Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes the key
user interface elements.

1. The Waveform Record View is a graphical high-level view of the overall waveform record length, how much of the record is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms cursors.

If you are displaying a Reference waveform that is shorter than the current acquisition record length, or you are changing the
horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the part of the waveform
record that is being viewed relative to the current acquisition total record length.

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed lines.

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface on page 38.
2. The Expansion Point icon on the waveform view shows the center point around which the waveform expands and compresses when

changing horizontal settings.

3. The Trigger Position Indicator shows where the trigger event occurred in the waveform record. The trigger icon is displayed in the
waveform slice that is the trigger source.
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4. The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off. The front panel Zoom button and knobs
also turn on zoom mode and change the position and horizontal size of the Zoom Box.

5. The Trigger Level Indicator icon(s) shows the trigger level on the trigger source waveform. Some trigger types require two trigger
levels.

6. Measurement and Search badges show measurement and search results. See Badges on page 28. See Add a
measurement on page 51.

7. The Results Bar Handle opens or closes the Results bar, to maximize waveform screen viewing when needed. To reopen the
Results bar, either tap the handle icon or swipe left from the right side of the display.

8. The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time). See
Badges on page 28.

9. The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the Settings
bar.

The Add New Math, Add New Ref, and Add New Bus buttons add the corresponding signal to the Waveform view, and add an
associated Waveform badge to the Settings bar. You can add any number of Math, Reference, and Bus waveforms, limited only by
system memory.

The optional AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the AFG
option is installed.

The optional DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT.
Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a trigger
frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only present if the DVM
option is installed.

10. Double-tap a badge to open its associated configuration menu. See Badges on page 28. See Configuration menus on page 37.

If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at each end of
the waveform badge area to scroll and display hidden badges.

11. The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, Mx for Math waveforms, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default. The
currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, each individual digital signal labeled D0–D7 and displayed
with a different color.

Double-tapping a digital waveform handle opens the digital channel configuration menu.

Dragging a digital signal handle over another handle swaps those two signals on the waveform.

The probe Dynamic Range Limit Markers are displayed just within the left-hand graticule edge, based at the channel vertical trace
handle position and extending up and down to the dynamic range limits of the probe. The markers are only displayed if compatible
probes are used. Signals must be within the probe dynamic range for the oscilloscope to correctly display and measure the signals.
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The markers are displayed, for about three seconds, after any Offset, Position, or Scale control change that leaves the channel
dynamic range limits within the acquisition window. After about three seconds the markers become short lines at the left edge of the
graticule. If the dynamic range is too small to display the arrows, the arrows are omitted. Examples of all three marker versions are
shown.

Badges
Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast access to
configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges
Channel and Waveform (Math, Ref, Bus, Trend) badges are shown in the settings bar, located along the bottom left of the screen. Each
waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a badge to open
its configuration menu.

Most Channel and Waveform badges also have Scale buttons, shown by single-tapping the badge. Use the Scale buttons to increase or
decrease the vertical scale setting for that waveform.

You can drag Channel and Waveform badges to change their position in the Settings bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the bottom edge of the display to remove it from the Settings bar. Flicking upwards from the bottom edge of the

Settings bar recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Channel badges are listed in the channel order unless you have moved them. Channel badges may also display short error or warning
messages. For more information double-tap the badge to open its configuration menu, or search the instrument Help.

Waveform badges (Math, Ref, Bus, Trend) are listed in the order created (unless they have been moved), and are grouped together by
type. Deleting a Waveform badge does not change the order or names of the remaining badges.
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Measurement badges
Measurement badges are located in the Results bar. They show measurements or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Add New Measurement button and select a measurement.

Double-tap a Measurement badge to open its configuration menu to change or refine settings. The default measurement badge readout
shows the measurement's mean (μ) value.

Some measurements and their badges are only available as options. For example, Power measurements are only listed in the Add New
Measurement menu if the required power option is installed.

Wide Badge: Wide badge displays all the phases results in a separate column. All sub-measurements are listed in the results badge in
the first column. The common result such as Frequency is applicable to all the (3) phases and displayed as single value. The configured
sources for each phase are displayed in channel colors. The Wide Badge applies to IMDA measurements only.

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu and select
Show Statistics in Badge. The measurement badge displays the standard deviation (σ) value. The standard deviation is zero, when the
population is one.

Some Measurement badges also have Navigation buttons, shown by single-tapping the badge.
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The < (Previous) and > (Next) buttons center the waveform in the display at the position of the previous or next measurement point in the
record (for measurements that take more than one measurement per acquisition).

The Min' and Max' navigation buttons center the waveform in the display at the minimum or maximum value for that measurement in the
current acquisition.

The prime symbol (') shown on measurement readings and Min/Max buttons indicates that the value shown (or moved to in the case of
Min/Max buttons and waveforms) is from the current acquisition. Lack of a prime symbol means the value is from all acquisitions.

The Measurement badge displays Status and Failures information when pass/fail testing is enabled through the configuration menu. The
Status line shows Pass (green) or Fail (red) according to the conditions defined in the Pass/Fail Testing panel. The number of Failures
are displayed when statistics are shown in the badge. The Pass/Fail status, number of Failures, and the Limit(s) set in the Pass/Fail
Testing panel are available in the Measurement Results table.

Measurement badges are listed in the order created, starting at the top of the Results bar. Deleting a Measurement badge does not
change the order or names of the remaining badges.

You can drag Measurement badges to change their position in the Results bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Mask Test badge
The mask test results and measurement statistics are displayed in the Mask Test badge in the Results bar. The badge is created when the
first segment of a mask is defined.

Badge readout Description
Label (optional readout) A label defined in the badge configuration menu.
Tested The total number of waveforms tested against the mask.
Passed The number of waveforms that contained no samples that violated the mask.
Failed The number of waveforms that contained one or more samples that violated the mask.

Displays in red if greater than or equal to the total failures threshold.
Table continued…
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Badge readout Description
Cons The highest number of consecutively failed waveforms in the test run. Displays in red if

greater than or equal to the consecutive failures threshold.
Status The status of the mask test. It can be On, Off, Passed/Passing (green) or Failed/Failing

(red).
Seg n (optional readout) The number of waveforms that contained one or more samples that violated mask segment

n.

Double-tap a Mask Test badge to open its configuration menu to change or refine settings.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.

There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Waveform Histogram badges
The Waveform Histogram badges are located in the Results bar. The badge title shows the histogram source.

To add the Waveform Histogram badge to Results bar, set the Display to On from the Result Badge menu. Double-tap a Waveform
Histogram badge to open its configuration menu to change settings.

The histogram badge displays the measurements which are checked in the Result Badge menu.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.

There are two ways to delete Waveform Histogram badges.

• Right-click the badge and select Delete Histogram.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Cursor Badges
You can display the cursor readouts in a Cursors badge in the Results bar. The badge contents depend on the cursor in use.

To create a cursor readouts badge, turn on Cursors, double-tap a cursor readout to open its configuration menu, and set the Readouts
mode to Badge.

Note: You can only view cursor readouts in one location at a time; either on the waveform or in a Cursors badge. You cannot
move cursor readouts to a badge for Spectrum View cursors.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
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There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Search badges
Search badges are also shown in the Results bar, below the Measurement badges. A search badge lists the search source, search type,
and the number of search event occurrences in the current acquisition. The instrument marks the waveform where those events occur with
small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to open its configuration menu to change
or refine search settings.

Search badges are created by tapping the Add New... Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the display
at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only usable when the
oscilloscope is in single acquisition mode. Single-tap a badge to close the Navigation buttons.

Some searches also provide Min and Max navigation buttons that open the Zoom mode and center the waveform in the display at the
minimum or maximum value for that search event in the current acquisition.

Search badges are listed in the order created. Deleting a Search badge does not change the order or names of the remaining badges.

You can drag Search badges to change their position in the Results bar and open the badge right-click menu to access a quick-action
menu.

There are two ways to delete Channel and Waveform badges.

• Right-click the badge and turn it off.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Deleting mass Measurements/Searches badges at once
This badge helps you to delete/remove many number measurements or searches, which are in the Results bar.

1. Select and right click on the Measurement/Search badge in the Results bar, which displays the dialog box as shown:

Controls Description
Configure Measurement/Search Configure Measurement or Search badges
Table continued…

Getting acquainted with your instrument

32



Controls Description
Delete Measurement/Search/Histogram Deletes the selected Measurement (standard, power, jitter, DDR, etc.)/Search/Histogram

badge in the Results bar.
Delete All Measurement/Search/
Histogram

Deletes all the Measurement (standard, power, jitter, DDR, etc.)/Search/Histogram
badges in the Results bar.

2. When Delete All Measurements is selected, the oscilloscope asks for the confirmation to delete all the measurements/search at a
time.

3. The dialog box provides you a checkbox that gives the choice to bypass remaining information dialogs.

• Don’t ask for remaining items: Default is unchecked. If you leave it unchecked and clear the information dialog, then the dialog
will appear again for the next measurement deletion.

• If the box is checked, it proceeds with deleting the rest of the items without bringing up the dialog box again. The dialog box
appears for each set of measurements you want to delete.

Signal Clipping and Badges
WARNING: Clipping is caused by excessive or dangerous voltage at the probe tip, and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and cause
damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the words Clipping in a Channel badge when a vertical clipping condition exists. Any
measurement badges associated with that channel also indicate a clipping condition by turning the measurement text red and listing the
type of clipping (positive or negative).

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the excessive voltage
source, and check that you are probing the correct signal using the correct probe.

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved waveform
files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.

Error Messages and Badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.

To remove the message from the badge, clear the error as indicated in the table.
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Table 1: Probe errors

Error message Description
Prb Comm Accessory communication timed out. Please re-attach the accessory.
Prb ROM Unable to read probe ROM. Please re-attach the accessory.
Unsup Accessory is unsupported.
Prb Fault Critical accessory fault. Please re-attach the accessory. If the problem persists, contact

Tektronix service.
Over Rng The signal voltage or current is over range. Please reduce the signal amplitude.
Temp The probe has experienced an over temperature condition. Please remove the probe from

the high temperature area.
No Tip No probe tip detected. Please install a compatible probe tip.
Tip Fault The probe tip has a fault. Please remove and replace the probe tip.
S-param Error during S-parameter transfer. Please reattach the probe. If the problem persists,

contact Tektronix Service.

History badge
The History badge is shown in the Results bar. Navigate the history acquisitions by using the Previous/Next or Play/Pause buttons.

Timestamp shows the time difference between the previous acquisition and the selected acquisition.

 

Badge readout Function Description
Previous The previous button takes you to the previous acquisition.

Next The next button takes you to the next acquisition.

 
Play/Pause Acquisitions are played at the specified playback speed and begin from the

currently selected acquisition. The Play button changes to a Pause button when
playback is active. Acquisitions are played until playback reaches the end of the
history. At this point, playback stops, and the Play button is grayed out.

Rewind The Rewind button takes you back to the acquisitions where you pressed the Play
button.

Reset The Reset button takes you back to the first acquisition in the history. When you
are at the beginning of the history the button is grayed out.

The waveforms can be viewed in the graticule for the selected acquisitions from history badge. You can navigate the total number of
acquisitions in history. Double-tap a badge to open its configuration menu.

When Include Reference Acquisition in Badge is selected from the right click menu of the History badge, the badge displays the
following information:
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The Reference acquisition readout shows the timestamp when the acquisition occurred in time in history. It also displays the delta between
the Selected acquisition and the Reference acquisition timestamps.

There are two ways to delete the History badge.

• Right-click the badge and select Disable Acquisition History.
• Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar

recovers the badge. Badge recovery is only possible within 10 seconds of removal.

System badges
System badges (in the settings bar) display the main Horizontal, Acquisition, and Trigger settings. You cannot delete System badges.

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase or
decrease the horizontal time setting.

Common badge actions
Action Result Example
Single tap Immediate access controls (Scale,

Navigation).

Table continued…
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Action Result Example
Double tap Configuration menu with access to all

settings for the badge.

Touch and hold Right-click menu with single tap
access to common actions. Typical
actions include turning off a channel
and deleting a measurement or
search badge.

Flick Flick the badge off the bottom edge of the display to remove it from the Settings bar.

Flick the badge off the right edge of the display to remove it from the Results bar.

Flick from the right or bottom edge to recover a removed badge. This action is only possible within 10 seconds of
badge removal.

Badge selection status
The appearance of a badge indicates its selection status (selected or unselected), or if a measurement needs to be deleted to close a
channel or waveform badge.

Badge type Selected Unselected Turned off or in use
Channel or
Waveform

Measurement N/A

A dimmed Channel badge means the screen waveform is turned off (but not deleted). A dimmed Waveform badge means that the
waveform display is turned off, or it is being used as a source by a measurement and cannot be deleted until the measurement is deleted.
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Configuration menus
Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition), measurements,
cursor readouts, Waveform and Plot views, callout text, and so on.

Double-tap an item (badge, Waveform View or Plot View, cursor readouts, callout text, and so on) to open its configuration menu. For
example, double-tap a Channel badge in the Settings Bar to open its configuration menu.

Selections or values that you enter take effect immediately. Menu contents are dynamic, and can change depending on your selections,
instrument options, or attached probes.

Related settings are grouped into 'panels'. Tap the panel name to show those settings. Changes to panel settings can change the values
and/or fields shown in that panel and other panels.

Tap anywhere outside a configuration menu to close it.

To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.
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Zoom user interface
Use the zoom tools to magnify waveforms to view signal details.

1. The Zoom Overview shows the entire waveform record. All waveforms are shown in Overlay mode in the Zoom Overview area. Using
pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

2. The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 5). You can touch and drag the box to move
the area to view. Moving the Zoom Box, or changing its position, does not change the horizontal time base settings. You can also use
the zoom Pan knob to move the Zoom Box left or right.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.
4. The DRAW-A-BOX button toggles between drawing a zoom box (default mode), drawing areas for the Visual Trigger function,

drawing segments for Mask testing, and drawing the Waveform Histogram for waveform analysis. The button is located at the bottom
of the Results Bar.

A zoom box lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview. Drawing a box immediately
puts the oscilloscope into zoom mode. To draw a zoom box, tap the DRAW-A-BOX button (while in Zoom mode), then touch and drag
on the waveform to draw a box waveform. You can continue to draw zoom boxes until you single tap anywhere on the screen or open a
menu.

To toggle between Zoom mode, Visual Trigger mode, and Mask mode, double-tap the DRAW-A-BOX button and select one of the
options. Search for the Visual Trigger and Mask Testing topics in the oscilloscope Help for more information.

5. The Zoom View shows the zoomed waveforms, as marked by the Zoom Box, in the Zoom Waveform Record View. Use pinch and/or
drag options in the zoom view to change the zoomed area of interest. Pinch, expand, and drag gestures in the Zoom View only change
zoom magnification settings and Zoom Box position.

6. Use the Zoom Title Bar controls to adjust the vertical and horizontal size of the zoom area. Click or tap the + or - buttons or use the A
and B multipurpose knobs.

In a waveform view, if both Cursor and Zoom are turned on, use the Zoom Box and Cursors button to change the multipurpose knob
functionality. Tap the Zoom Title Bar to assign the knobs to adjust the zoom or tap the Cursors button to assign knobs to adjust the
cursors.

Double tap the Horizontal Zoom Position or Horizontal Zoom Scale fields to enter a value using a numerical keypad.
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To exit the zoom display mode, tap the Zoom icon in the corner of display or tap the X in the Zoom Title Bar.
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Configure the instrument
Configurations to help operate your instrument efficiently. Refer to the instrument help for additional configuration information.

Set the time zone and clock readout format
Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the time format
(12 or 24 hour clock).

About this task
To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

Procedure

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.
2. To turn off showing the date and time on the screen, tap Display button to Off.

To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the configuration
menu, and set the Display button to On.

3. Select a time format (12 Hour or 24 Hour).
4. Tap the Time Zone field and select the time zone that applies to your location.
5. Tap anywhere outside of the menu to close it.

Download and install the latest instrument firmware
Installing the latest firmware helps ensure that your instrument has the latest features and is taking the most accurate measurements.

Before you begin
Save any important on-instrument files (waveforms, screen captures, setups, and so on) to a USB drive or network. The installation
process does not remove user-created files, but it is a good idea to back up important files before an update.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Procedure
1. Power on the oscilloscope.
2. Determine the current version of firmware installed on the instrument in the About window under the Help menu
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3. Check the version of the latest available firmware at the tek.com/software. Enter the model number of your oscilloscope in the search
box and search for the firmware.
If the firmware version on the web is newer than what is currently installed, update your instrument firmware.

4. Install the firmware on embedded OS instruments.
a) Download the latest firmware and unzip the files on your PC.
b) Copy the designated firmware file into the root folder of a USB flash drive.
c) Insert the USB flash drive into a USB port on your oscilloscope. The instrument automatically recognizes the firmware install file

and starts the installation process.
d) Follow any on-screen instructions. The oscilloscope take about 10 minutes to install the new firmware.

Do not remove the USB flash drive or power off the instrument during this time.
e) After the oscilloscope displays a message that it has completed the upgrade, the scope will reboot automatically.

What to do next
To confirm the firmware update, locate the version number found in the About window under the Help menu. Confirm that the instrument
firmware version number matches the firmware version number that you just installed.

Run Signal Path Compensation (SPC)
Run SPC when you first receive an instrument, and at regular intervals, for best measurement accuracy. You should run SPC whenever
the ambient (room) temperature has changed by more than 5 °C (9 °F), or once a week if you use vertical scale settings of 5 mV per
division or less.

About this task
To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations and/or
long-term signal path drift. Failure to run SPC on a regular basis may result in the instrument not meeting warranted performance levels at
low volts per division settings.

Before you begin
Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

Procedure
1. Power on and warm up the instrument for at least 20 minutes.
2. Tap Utility > Calibration.
3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take three minutes approximately per channel

to run, so wait until the SPC Status message changes to Pass before reconnecting probes or cables and using the instrument.

CAUTION: You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.
If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected and run the SPC again. If
the SPC still fails, contact Tektronix Customer Support.
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Compensate the TPP Series probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for an unlimited number of probe/channel combinations.

About this task
To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

The oscilloscope stores the compensation values for each probe/channel combination, and automatically recalls the compensation values
when you plug in the probe. Probe compensation status is shown in the Probe Setup panel of the Channel configuration menu.

• If the Probe Compensation Status field displays Pass, the probe is compensated and ready for use.
• If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have this probe

compensation procedure run.
• If the Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure. Reconnect the

probe and run probe compensation again.
• If there is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for that probe.

See the oscilloscope Help for how to manually compensate passive probes not supported by the probe compensation function.

Before you begin
The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

Procedure
Use this procedure to compensate supported TPP-family probes that show a Default status when connected to the oscilloscope.

Note: Doing a Default Setup does not delete probe compensation values. A factory calibration does delete all stored probe
compensation values.

1. Connect a supported probe to an input channel.
2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals.

Note: Connect only one probe at a time to the PROBE COMP terminals.
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3. Turn off all channels.
4. Turn on the channel to which the probe is connected.
5. On the MSO58LP, select File > Autoset from the menu bar. The screen displays a square wave.
6. Double-tap the badge of the channel that you want to compensate.
7. Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe to another
channel and start again from step 1, or connect a different probe to this channel and start from step 1. If the Probe Compensation
Status says Default, continue with this procedure.

8. Tap Compensate Probe to open the Probe Compensation dialog.
9. Tap Compensate Probe to run the probe compensation.
10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and ground from

the PROBE COMP terminals.
11. Repeat these steps for each supported passive probe that you want to compensate for this channel.
12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

Note: For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

Connect to a network (LAN)
Connecting to a network allows you to remotely access the instrument.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP address,
Subnet Mask, DNS IP address, and so on).

1. Connect a CAT5 cable from the instrument LAN connector to your network.
2. Select Utility > I/O on the menu bar to open the I/O configuration menu.
3. Obtain or enter the network address information:

• If your network is DHCP-enabled, and the IP address field does not already show an address, tap Auto to obtain the IP address
information from the network. DHCP mode is the default mode.

• If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument, tap Manual and
enter the IP address and other values provided by your IT or system administrator resource.

4. Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the instrument
successfully connects to your network. If you have problems connecting to your network, contact your system administration resource
for help.

The front panel LAN status LED colors display the network connection status:

• Off: No power to the instrument
• Green: Network connection is good
• Red: Network connection has a fault or is not connected
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Remote access from a Web browser
You can remotely access your network-connected standard instrument (not running Windows) from a Web browser to display the
instrument user interface on a PC.

This procedure describes how to remotely access the UI controls and screen for standard (non Windows 10) instruments. To remotely
access the UI controls and screen for Windows 10 instruments, see the Remote access to a Windows 10 instrument topic in the Help.

Prerequisites:

• The instrument must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network
(LAN) on page 43

• The IP address of the instrument that you want to access. To determine the instrument's IP address, select Utility > IO in the
instrument menu bar and view the network settings in the LAN panel.

• You are accessing a standard (instrument that does not have the Windows OS option installed).

Use below procedure to remotely access the UI controls and screen for standard (non Windows 10) instruments using e*Scope®

functionality.

1. Open a Web browser on a PC connected to the same network as the instrument.
2. Enter just the instrument IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The browser

searches for and opens the Web page for the instrument.
3. Select Instrument Control (e*Scope). The browser displays the instrument screen. If a password is set for the e*Scope, an Enter

Password window will popup. Enter the password and tap Submit. If the password is input incorrectly five times, it will block the
e*Scope for five minutes.

4. Use a mouse to select and interact with the instrument controls shown in the Web browser. If your remote PC or laptop has a touch
screen monitor, you can use the remote touchscreen monitor to access the instrument controls.

Close the browser to logout the session.

Note: If connection error occurs, refresh the page in the web browser or restart the web browser for seamless interaction with the
instrument remotely.

When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address information, and so
on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is available in the e*Scope application.
Use the following steps to copy text from an e*Scope-connected PC to the instrument:

1. Open a connection to the instrument using e*Scope.
2. Select and copy the text on your PC.
3. In e*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.
4. Paste the text into the Clipboard field.
5. Press Ctrl-Alt-Shift to close the browser Clipboard menu.
6. Use e*Scope to open the instrument menu to which to paste content, and position the cursor in the field where you want to paste the

text.
7. Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the menu field.
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8. Repeat steps 2 on page 44 through 7 on page 44 to copy and paste other text from the PC to the instrument.
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Operating basics
These procedures are an introduction to using the interface to do common tasks. Refer to the instrument help for detailed information on
menu and field settings.

Add a channel waveform to the display
Use this procedure to add a channel signal to the Waveform View.

1. Connect signal(s) to the channel input(s).
2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

The selected channel is added to the Waveform View and a Channel badge is added to the Settings bar.
3. Continue tapping Inactive Channel buttons to add more channels (digital or analog). Channels are displayed from lowest-numbered

channel at the top, to highest-numbered channel at the bottom of the view, regardless of the order they were added (in stacked mode).
4. Double-tap a channel badge to open that channel's configuration menu to check or change settings.

Configure channel or waveform settings
Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth, probe
settings, deskew values, external attenuation values, and other settings.

Before you begin
Prerequisite: There is a channel or waveform badge in the Settings bar.

Procedure
1. Double-tap a Channel or Waveform badge to open a configuration menu for that item.

For example, in a Channel menu, use the Vertical Settings panel to set basic probe parameters such as vertical scale and position,
offset, coupling, termination, and bandwidth limit. Available settings depend on the probe.

2. Tap the Probe Setup panel to confirm probe settings and run configuration or compensation on supported probes.

3. Tap the Other panel to set probe deskew, external attenuation, and alternate units parameters.
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4. Tap the Help icon on the menu title to open the help topic for more information.
5. Tap outside the menu to close the menu.

Autoset to quickly display a waveform
The Autoset function analyzes the signal characteristics and changes the instrument Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the waveform
point of interest.

1. Connect the probe with the signal of interest to an available channel. The signal can be analog or digital.
2. Double-tap the Trigger badge and set the trigger source to that of the signal of interest.
3. Connect any other associated signal(s) to available channel input(s).
4. Add the channel waveforms to the Waveform view. See Add a channel waveform to the display on page 46.
5. Tap File > Autoset or push the front-panel Autoset button. When using the Stacked Display mode, the instrument analyzes the signal

characteristics of the trigger source channel (analog or digital) and adjusts the horizontal, vertical, and trigger settings accordingly
to display a triggered waveform for that channel. The Vertical scale is adjusted in each waveform slice of all active waveforms to
maximize ADC utilization.

When using the Overlay Display mode, the instrument adjusts the horizontal and trigger settings of the trigger source channel to
display a triggered waveform for that channel. Vertical scale and position adjustments for all active channels in Overlay Display mode
are controlled by the Autoset in Overlay Display Mode Optimizes selection in the Autoset panel of the User Preferences menu. If
the selection is Visibility, Autoset vertically scales and positions all active channel waveforms such that they are uniformly spaced on
screen. If the selection is Resolution, Autoset vertically scales and positions all active channel waveforms such that they each use as
much of the ADC's range as possible.

Note: You can set which parameters the instrument can adjust when running an Autoset. Access the Autoset panel in Utility >
User Preferences > Autoset.
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Autoset guidelines
• Autoset displays three or four cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.
• The trigger is set to type Edge, rising slope, DC coupling.
• If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the Waveform view whether it has a signal or not.
• Autoset ignores math, reference, and bus waveforms.
• A channel or waveform with a frequency less than 40 Hz is classified as no signal.

How to trigger on a signal
Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.
2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the illustration

to show a graphic of the trigger type.

Note: For the MSO58LP, the AUX In external trigger input only supports Edge triggering.

To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus waveform on page 50

Note: Triggering on buses other than Parallel requires purchasing and installing serial trigger and analysis options.

3. Select the other fields and panels to refine the trigger conditions. The menu fields and trigger graphic updates as you make changes to
the trigger settings. Displayed fields depend on the selected trigger type. Selection changes take effect immediately.

4. Tap the Help icon on the menu title for more information on these settings.
5. Tap outside the menu to close the menu.

Set the acquisition mode
Use this procedure to set the method the instrument uses to acquire and display the signal.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.
2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected acquisition type.
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3. Tap the Help icon on the menu title for more information on these settings.
4. Tap outside the menu to close the menu.

Set Horizontal parameters
Use this procedure to set the horizontal time base parameters such as mode, minimum sample rate, horizontal scale, delay, and trigger
delay time (relative to the center of the waveform record.

1. Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.

2. Use the menu selections to set horizontal parameters.
3. Tap the Help icon on the menu title for more information on these settings.
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Add a math, reference, or bus waveform
Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and analyze
serial or parallel data.

There is no set limit to the number of Math, Reference, or Bus waveforms you can add to the Waveform View, other than system physical
memory constraints.

1. Tap the Add New Math, Add New Ref, or Add New Bus button in the Settings bar.

2. The instrument adds the waveform to the Waveform view, adds a Waveform badge to the Settings bar, and opens a configuration
menu. This example shows adding a Math waveform.

3. Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections made in the
menu. Selection changes take effect immediately.

This example shows adding a Math waveform, using the Math Source fields to select Ch 1 and Ch 2 as the waveform sources, set the
math type to Basic math operation, and subtracting channel 2 from channel 1.

4. When adding a Reference waveform, the instrument displays a Recall configuration menu. Navigate to and select the reference
waveform file (*.wfm) to recall, then tap the Recall button. The instrument displays the Reference waveform.

5. Double-tap a math, reference, or bus badge to check or change the waveform settings.
6. Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.
7. Tap outside the menu to close the menu.
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Add a measurement
Use this procedure to select and add measurements.

1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.

Note: Waveforms do not need to be displayed to be used for measurements, as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2. Tap the Add New...Measure button to open the Add Measurements configuration menu or drag the Measure button onto a
waveform in the waveform display area to automatically set the source.

Note: If the menu shows tabs other than Standard, then optional measurement types have been installed on the
instrument. Select a tab to show the measurements for that option.

3. Tap the Source field and select the measurement source. The list shows all available sources of analog 8 port or digital 16 port
channel that are valid for the measurement.
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4. Select a measurement category panel, such as Amplitude Measurements or Timing Measurements, to display measurements for
those categories.

5. Some optional measurement packages are available in this menu as well like PWR, DJA, DBDDR3, DPM, IMDA, and WBG-DPT.
6. Select a measurement and tap Add to add the measurement to the Results bar. You can also double-tap a measurement to add it to

the Results bar.

7. Select and add other measurements for the current source. Tap the measurement category panels to display and select other
measurements to add.

8. To add measurements for other sources, select a different source, select a measurement, and add the measurement.

9. Tap outside the Add Measurements menu to close the menu.
10. To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that measurement.

See Configure a measurement on page 53.
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11. Tap the Help icon on the menu title for more information on settings.

Configure a measurement
Use this procedure to add statistical readouts to the measurement badge, display plots for the measurement, and refine measurement
parameters (configuration, global versus local scope of settings, gating, filtering, and so on).

1. Double-tap a measurement badge to open its Measurement configuration menu.

2. Tap Show Statistics in Badge to add statistical readouts to the measurement badge.

3. Tap available panel titles to make changes for those categories.

4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection changes take
effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.
6. Tap outside the menu to close the menu.
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Add a plot of a measurement
Measurement plots let you graph the distribution of waveform data point occurrences (histogram), plot the frequency components
(spectrum) of a waveform, show the time trend of a measurement, display an eye diagram, and other supported plots. Available plots
depend on the measurement.

1. Double-tap a Measurement badge to open the Meas configuration menu.

2. Tap a Plots button to add that plot for the measurement to the screen.

The following shows adding a Histogram plot.
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You can add more than one plot to measurements (to different measurements or the same measurement). For example, you can add
two histogram plots for the same measurement, set one to display the X-Axis with a Logarithmic scale, and the other plot to display the
X-Axis with a Linear scale.

3. You can move plot windows by dragging the Plot view title bar to a new position. The blue background area moves to show where the
plot will be located when you remove your finger from the title bar. You can also resize plot windows by selecting and dragging the Plot
view border. You should use a mouse to do these operations, as it is easier to select and drag plots with a mouse.

4. Double-tap within a Plot view to open a configuration menu to set display characteristics. Tap the Help icon on the configuration menu
title for more information on that menu's settings. Tap outside the menu to close the menu.

Add a Search
Use this procedure to set search criteria and mark a waveform where those events occur.

You can search on analog and digital signals, math waveforms, and reference waveforms. You can add searches to different waveforms
and multiple searches to the same waveform.

Prerequisite: Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

1. Tap the Add New...Search button to open the Search configuration menu.
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2. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select the
Search Type, Source, and conditions on which to search).

Note: You cannot search for sequential events (there is no Sequence search type).

3. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. Each search uses a
different color for its markers. The example image shows search criteria set to find positive pulse widths that are less than 70 ns wide.

4. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.
5. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap a Search

badge, and tap the < or > Navigation button.

Note: Navigation buttons are only functional when the oscilloscope acquisition mode is set to Stop.

This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.
6. If available for a search, tap the Min or Max button to center the waveform in the display at the minimum or maximum value of the

search events in the waveform record.
7. To return the instrument to normal acquisition mode, tap the Zoom icon in the upper right corner of the Waveform View to turn off

Zoom mode, and push the Run/Stop front-panel button to set it to Run mode.
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Delete a Measurement or Search badge
Use this procedure to remove a Measurement or Search badge from the Results bar.

1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.
2. Select Delete Meas to delete that badge from the Results bar.

Note: You can undo a measurement delete.

3. The second way to delete a Measurement or Search badge is by flicking it off the right edge of the display. Flicking to the left from the
right edge of the display recovers the badge.

Note: Badge recovery is possible within 10 seconds only of removal.

Change waveform view settings
Use this procedure to change the waveform display mode (Stacked or Overlay), waveform trace interpolation algorithm, waveform
persistence, style and intensity, and graticule style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.

2. Tap the buttons in the Display Mode to toggle between Overlay and Stacked modes.
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3. Use the other controls to set the waveform interpolation algorithm, waveform point persistence, style, and intensity, and graticule style
and intensity.

4. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view
parameters.

5. Tap outside the menu to close the menu.

Display and configure cursors
Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform or plot, or between two different
waveforms. Cursor readouts show both current position values and the difference (delta) between cursors. Polar cursor readouts are
available through the cursor configuration menu for XY and XYZ plots.

1. Tap the waveform slice (in Stacked mode), or the channel or waveform badge (in Overlay mode) to which you want to add cursors.
2. Tap the Add New...Cursors button, or push the front-panel button. The cursors are added to the display.

3. Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors show readouts that show position and
difference measurements between the cursors.

4. To move the cursors to a different channel or waveform, just tap in that waveform graticule.
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5. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration menu. For
example, tap the Cursor type to select the cursors to display, such as Waveform, V Bars, H Bars, and V&H Bars.

The cursor configuration menu in the waveform view.

The cursor configuration menu in an XY plot.

6. To split the cursors between two waveforms, tap the Source field and select Split and select the source for each cursor. The cursors
are moved to the specified waveforms.
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7. Tap the Help icon on the menu title for more information on the menu settings.
8. To stop showing cursors, push the front panel Cursor button, press and hold to open the right-click menu and turn cursors off, or open

the Cursors configuration menu and set Display to Off.

Remote access from a Web browser
You can remotely access your network-connected standard instrument (not running Windows) from a Web browser to display the
instrument user interface on a PC.

This procedure describes how to remotely access the UI controls and screen for standard (non Windows 10) instruments. To remotely
access the UI controls and screen for Windows 10 instruments, see the Remote access to a Windows 10 instrument topic in the Help.

Prerequisites:

• The instrument must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network
(LAN) on page 43

• The IP address of the instrument that you want to access. To determine the instrument's IP address, select Utility > IO in the
instrument menu bar and view the network settings in the LAN panel.

• You are accessing a standard (instrument that does not have the Windows OS option installed).

Use below procedure to remotely access the UI controls and screen for standard (non Windows 10) instruments using e*Scope®

functionality.

1. Open a Web browser on a PC connected to the same network as the instrument.
2. Enter just the instrument IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The browser

searches for and opens the Web page for the instrument.
3. Select Instrument Control (e*Scope). The browser displays the instrument screen. If a password is set for the e*Scope, an Enter

Password window will popup. Enter the password and tap Submit. If the password is input incorrectly five times, it will block the
e*Scope for five minutes.

4. Use a mouse to select and interact with the instrument controls shown in the Web browser. If your remote PC or laptop has a touch
screen monitor, you can use the remote touchscreen monitor to access the instrument controls.

Close the browser to logout the session.
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Note: If connection error occurs, refresh the page in the web browser or restart the web browser for seamless interaction with the
instrument remotely.

When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address information, and so
on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is available in the e*Scope application.
Use the following steps to copy text from an e*Scope-connected PC to the instrument:

1. Open a connection to the instrument using e*Scope.
2. Select and copy the text on your PC.
3. In e*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.
4. Paste the text into the Clipboard field.
5. Press Ctrl-Alt-Shift to close the browser Clipboard menu.
6. Use e*Scope to open the instrument menu to which to paste content, and position the cursor in the field where you want to paste the

text.
7. Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the menu field.
8. Repeat steps 2 on page 61 through 7 on page 61 to copy and paste other text from the PC to the instrument.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > I/O from the menu bar.
2. Tap USB Device Port Settings.
3. Confirm that the USB Device Port control is On (default setting).
4. Connect a USB cable from the PC to the USB Device port on the instrument.
5. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address for your

configuration (0 - 30).

ESD Prevention Guidelines
Electrostatic discharge (ESD) can damage oscilloscope and some probe inputs. This topic discusses how to avoid this type of damage.

Electrostatic discharge (ESD) is a concern when handling any electronic equipment. The instrument is designed with robust ESD
protection, however it is still possible that large discharges of static electricity directly into the signal input may damage the instrument. Use
the following techniques to prevent electrostatic discharge from damaging the instrument.

• Discharge the static voltage from your body by wearing a grounded antistatic wrist strap while connecting and disconnecting cables,
probes, and adapters. The instrument provides a ground connection to which to attach a wrist strap (on the Probe Comp ground
connector).
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• A cable that is left unconnected on a bench can develop a large static charge. Discharge the static voltage from all cables before
connecting them to the instrument or device under test by momentarily grounding the center conductor of the cable, or by connecting a
50 Ω termination to one end, before attaching the cable to the instrument.

• Before you apply power, connect the instrument to an electrically-neutral reference point, such as earth ground. To do this, plug the
three-pronged power cord into an outlet grounded to earth ground. Grounding the oscilloscope is necessary to ensure safety and to
take accurate measurements.

• If you are working with static sensitive components, ground yourself. Static electricity that builds up on your body can damage
static-sensitive components. Wear a wrist strap to safely send static charges on your body to earth ground.

• The oscilloscope must share the same ground as any circuits that you plan to test.
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Maintenance
This section contains information needed to perform periodic maintenance on the instrument.

CAUTION: Do not remove the top cover from the instrument except to replace a damaged cover. There are no user replaceable
parts inside the instrument. Return the instrument to Tektronix if it requires service.

Cleaning
Use a dry, soft cotton cloth to clean the outside of the unit. If any dirt remains, use a cloth or swab dipped in a 7 % isopropyl alcohol
solution. Use a swab to clean narrow spaces around controls and connectors. Do not use any liquid cleaning agents or chemicals that
could damage the case, controls, markings or labels, or possibly infiltrate the case.

Performance verification interval and adjustment
The voltage and timing references inside the instrument are very stable over time and do not need routine adjustment.

If periodic calibration is one of your organization's requirements, a general rule is to verify performance every 2000 hours of operation
or once a year if the instrument is used infrequently. Use the procedures in the instrument Specifications and Performance Verification
manual, available online at www.www.tek.com/product-support.

If the instrument fails the performance tests in the Specifications and Performance Verification manual, adjustment may be required.
Adjustment can only be performed by a Tektronix Service Center. See Contacting Tektronix, following the title page in this manual, for
information on contacting Tektronix Service Support.

Replaceable parts list
This section contains replaceable parts information for your instrument. Use the lists in the appropriate section to identify and order
replacement parts for your product. 

Standard accessories
Standard accessories for these products are listed near the beginning of this manual.

Replaceable parts
The following figure shows the user-replaceable parts for the instrument. There are no user-replaceable parts inside the instrument.
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Figure 3: MSO58LP replaceable parts diagram

Table 2: Replaceable parts list

Index number Tektronix part
number

Quantity Name & description

1 407-6088-xx 2 BRACKET, FRONT, RACK MOUNT, 2U EAR

2 211-1682-xx 14 SCREW, 10-32 X 5/16 BUTTON HEAD, CAP,
BLACK

3 407-6089-xx 2 BRACKET, REAR, RACK MOUNT, CHASSIS-
SIDE

4 407-6090-xx 2 BRACKET, REAR, RACK MOUNT, RACK-SIDE

5 020-3180-xx 1 BENCH CONVERSION KIT (optional accessory)

Not shown:
Table continued…
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Index number Tektronix part
number

Quantity Name & description

A0 1 North America power plug (115 V, 60 Hz)

A1 1 Universal Euro power plug (220 V, 50 Hz)

A2 1 United Kingdom power plug (240 V, 50 Hz)

A3 1 Australia power plug (240 V, 50 Hz)

A5 1 Switzerland power plug (220 V, 50 Hz)

A6 1 Japan power plug (100 V, 50/60 Hz)

A10 1 China power plug (50 Hz)

A11 1 India power plug (50 Hz)

A12 1 Brazil power plug (60 Hz)

Service the instrument
For more information on troubleshooting, maintenance, and replacing parts on your instrument refer to the instrument service manual or
contact a Tektronix Service Center.
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Returning the instrument for service
If the instrument has removable batteries, remove the batteries before repacking the instrument and do not include the batteries in the
shipment.

Note: Do not ship removable batteries to Tektronix Service Centers.

When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use, contact your local
Tektronix representative to obtain new packaging.

Seal the shipping carton with an industrial stapler or strapping tape.

Before returning the instrument for service, contact the Service Center to get an RMA (return material authorization) number, and any
return or shipping information you may need.

If the instrument is being shipped to a Tektronix Service Center, enclose the following information:

• The RMA number.
• The owner's address.
• Name and phone number of a contact person.
• Type and serial number of the instrument.
• Reason for returning.
• A complete description of the required service.

Mark the address of the Tektronix Service Center and the return address on the shipping carton in two prominent locations.
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Index

A
ACQ acquisition status LED 21
acquisition menu, open 48
add

a channel to the display 46
a measurement badge 51
a measurement plot 54
a search badge 55
signal to the screen 46
waveform to the screen 46

Add New
Bus waveform button 26
Math waveform button 26
Ref waveform button 26

AFG option 26
AFG Out (rear panel) 23
automatic probe compensation (TPP series) 42
Autoset 47
AUX Out (rear panel) 23
Aux Trig trigger input 21

B
badge types 28
badges 28
bus waveforms 50

C
cable lock 23
Callout button 24
change display settings 57
change measurement settings 53
channel badge 28
channel menu 46
channel settings 46
channel vertical parameters menu 46
clipping message 28
clock format (12/24 hr), how to set 40
compensate TPP series probes 42
configuration menus 37
configure a measurement 53
connect lock cable 18
connect to a network 43
connecting probes 20
Cursors button (touchscreen) 24
cursors menu 58

D
delete a measurement badge 57
display a channel 46
display cursors 58
documentation 16

Draw-a-Box button (Zoom) 38
DVM option 26
dynamic range limit marker 26

E
e*Scope 44, 60
electrostatic damage, preventing 61
Environment requirements 16
ESD, preventing 61
Ethernet port (rear panel) 23
Ethernet, connect to 43
expansion point, waveform 26

F
firmware, how to update 40
FlexChannel inputs 21
front panel controls 21

G
GPIB talk/listen address 61
graticule intensity 57
graticule style 57

H
handles, analog and digital 26
horizontal menu, open 49
how to

add a measurement 51
add a measurement plot 54
Add bus waveform 50
Add math waveform 50
Add reference waveform 50
add waveform to screen 46
change display settings 57
change graticule intensity 57
change graticule style 57
change measurement settings 53
change persistence 57
change waveform intensity 57
change waveform interpolation 57
check power-on self tests results 19
compensate TPP series probes 42
connect probes 20
connect to network 43
connect to PC using USB cable 61
delete a measurement 57
display cursors 58
download, install firmware 40
open acquisition menu 48
open horizontal menu 49
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how to (continued)
quickly display waveform (Autoset) 47
remote access the instrument (from Web) 44, 60
run signal path compensation (SPC) 41
search on an event 55
set acquisition parameters 48
set channel vertical parameters 46
set clock format (12/24 hr) 40
set GPIB talk/listen address 61
set horizontal parameters 49
set probe deskew 46
set probe parameters 46
set time zone 40
set trigger parameters 48
use Autoset 47

How to
change display mode (stacked, Overlay) 57

I
inactive channel buttons 26
input signal level requirements 17
intensity, graticule 57
intensity, waveform 57

L
LAN port (rear panel) 23
LAN status LEDs 21
LAN, connect to 43
lock to bench or rack 18

M
Maintenance

replaceable parts 63
manuals 16
marking waveform events (search) 55
math waveforms 50
Measure button 24
measurement

plots 54
measurement badge 28
measurement badge, delete 57
Menu bar 24
menu panels 37
menus 37
More button 24
move cursors 58

N
navigation buttons, badges 28
network, connect to 43

O
open acquisition menu 48

open horizontal menu 49
operating

altitude range 16
humidity range 16
temperature range 16

operating power requirements 16
overlay mode (waveforms) 57

P
Pan 38
panels, menu 37
persistence, waveform 57
plot a measurement 54
Plot button 24
power cord connector (rear panel) 23
power cords 63
power requirements 16
power standby mode 19
power-on test results 19
powering on or off 19
preventing ESD 61
probe comp connectors 21
probe deskew, set 46
probe parameters, set 46
probes, connecting 20

R
rear panel

AFG Out 23
AUX Out 23
cable lock 23
Ethernet port (RJ-45) 23
LAN port (RJ-45) 23
power cord 23
security cable lock 23
USB Device port 23
USB Host ports 23
video output 23

rear panel connections 23
record view, waveform 26
Ref In 23
Ref In (rear panel) 23
reference waveforms 50
remote access (e*Scope) 44, 60
remote access (Web-based) 44, 60
remove AC power from instrument 19
Replaceable parts 63
requirements

altitude 16
environment 16
humidity 16
power 16
signal inputs 17
temperature 16

Results bar 24
Results Table button 24
run signal path compensation 41
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S
scale buttons, badge 28
search badge 28
Search button 24
searching for events 55
security cable lock 23
set

clock format (12/24 hr) 40
GPIB talk/listen address 61
probe deskew 46
probe parameters 46
time zone 40

Settings bar 24
show a measurement 51
signal input levels 17
SPC (signal path compensation) 41
stacked mode (waveforms) 57
standard accessories 15

T
time zone, how to set 40
trigger

level indicators 26
position indicator 26

trigger menu 48
trigger the oscilloscope 48
turn instrument on or off 19

U
USB cable, connect to PC 61
USB Device port (rear panel) 23
USB Host ports (rear panel) 23
use cursors 58
user documentation 16

V
video output (rear panel) 23

W
waveform

expansion point 26
intensity 57
persistence 57
record view 26

waveform badge 28
Waveform View 24

Z
Zoom box 38
zoom icon 26
Zoom overview 38
Zoom title bar 38
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安全性に関する重要な情報

このマニュアルには、操作を行うユーザの安全を確保し、製品を安全な状態に保つために順守しなければならな
い情報および警告が記載されています。

本機の点検にあたっては「安全にご使用いただくために」に続く「安全に保守点検していただくために」を参照し

て、事故防止につとめてください。

安全にご使用いただくために

製品は指定された方法でのみご使用ください。人体への損傷を避け、本製品や本製品に接続されている製品の
破損を防止するために、安全性に関する次の注意事項をよくお読みください。すべての指示事項を注意深くお読
みください。必要なときに参照できるように、説明書を安全な場所に保管しておいてください。

本製品は該当する地域の条例や国内法令に従って使用しなければなりません。

本製品を正しく安全にご使用になるには、このマニュアルに記載された注意事項に従うだけでなく、一般に認めら
れている安全対策を徹底しておく必要があります。

本製品は訓練を受けた専門知識のあるユーザによる使用を想定しています。

製品のカバーを取り外して修理や保守、または調整を実施できるのは、あらゆる危険性を認識した専門的知識の
ある適格者のみに限定する必要があります。

使用前に、既知の情報源と十分に照らし合わせて、製品が正しく動作していることを常にチェックしてください。

本製品は危険電圧の検出用にはご利用になれません。

危険な通電導体が露出している部分では、感電やアーク・フラッシュによってけがをするおそれがありますので、
保護具を使用してください。

本製品をご使用の際に、より大きな他のシステムにアクセスしなければならない場合があります。他のシステムの
操作に関する警告や注意事項については、その製品コンポーネントのマニュアルにある安全に関するセクション
をお読みください。

本機器をシステムの一部としてご使用になる場合には、そのシステムの構築者が安全性に関する責任を果たさ
なければなりません。

火災や人体への損傷を避けるには

適切な電源コードを使用してください： 本製品用に指定され、使用される国で認定された電源コードのみを使用し

てください。他の製品の電源コードは使用しないでください。

本製品を接地してください： 本製品は、電源コードのグランド線を使用して接地します。感電を避けるため、グラン

ド線をアースに接続する必要があります。本製品の入出力端子に接続する前に、製品が正しく接地されているこ
とを確認してください。電源コードのグランド接続を無効にしないでください。

電源を切断してください： 電源コードの取り外しによって主電源が遮断されます。スイッチの位置については、使

用説明書を参照してください。電源コードの取り扱いが困難な場所には設置しないでください。必要に応じてすぐ
に電源を遮断できるように、ユーザが常にアクセスできる状態にしておく必要があります。

接続と切断の手順を守ってください： プローブとテスト・リードが電圧源に接続されている間は接続または切断し

ないでください。絶縁型の電圧プローブ、テスト・リード、およびアダプタは、製品に付属する製品か、または当社
により特別に指定された製品のみを使用してください。
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すべての端子の定格に従ってください： 発火や感電の危険を避けるために、本製品のすべての定格とマーキン

グに従ってください。本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参照してください。
測定カテゴリ（CAT）の定格および電圧と電流の定格については、製品、プローブ、またはアクセサリのうちで最も

低い定格を超えないように使用してください。1：1 のテスト・リードを使用するときは、プローブ・チップの電圧が直

接製品に伝わるため注意が必要です。

コモン端子を含むいかなる端子にも、その端子の最大定格を超える電圧をかけないでください。

端子の定格電圧を超えてコモン端子をフローティングさせないでください。

本製品の測定端子は、AC 電源、カテゴリ II、III、および IV 回路には使用できません。

カバーを外した状態では使用しないでください： カバーやパネルを外した状態やケースを開いたまま動作させない

でください。危険性の高い電圧に接触してしまう可能性があります。

露出した回路への接触は避けてください： 電源が投入されているときに、露出した接続部分やコンポーネントに触

れないでください。

故障の疑いがあるときは使用しないでください： 本製品に故障の疑いがある場合には、資格のあるサービス担当

者に検査を依頼してください。

製品が故障している場合には、使用を停止してください。製品が故障している場合や正常に動作していない場合

には、製品を使用しないでください。安全上の問題が疑われる場合には、電源を切って電源コードを取り外してく
ださい。誤って使用されることがないように、問題のある製品を区別しておいてください。

使用前に、電圧プローブ、テスト・リード、およびアクセサリに機械的損傷がないかを検査し、故障している場合に

は交換してください。金属部が露出していたり、摩耗インジケータが見えているなど、損傷が見られるプローブま
たはテスト・リードは使用しないでください。

使用する前に、製品の外観に変化がないかよく注意してください。ひび割れや欠落した部品がないことを確認して

ください。

指定された交換部品のみを使用するようにしてください。

湿気の多いところでは動作させないでください： 機器を寒い場所から暖かい場所に移動する際には、結露にご注

意ください。

爆発性のガスがある場所では使用しないでください：

製品の表面を清潔で乾燥した状態に保ってください： 製品の清掃を開始する前に、入力信号を取り外してくださ

い。

適切に通気してください： 適切な通気が得られるように製品を設置できるように、マニュアルの設置手順を参照し

てください。

製品には通気用のスロットや開口部があります。その部分を覆ったり、通気が妨げられたりすることがないように

してください。開口部には異物を入れないでください。

安全な作業環境を確保してください： 製品は常にディスプレイやインジケータがよく見える場所に設置してくださ

い。

キーボードやポインタ、ボタン・パッドを不適切に使用したり、長く押しすぎたりしないでください。キーボードやポイ

ンタの使用を誤ると、大けがにつながる可能性があります。

作業場が該当する人間工学規格を満たしていることを確認してください。ストレスに由来するけががないように、

人間工学の専門家に助言を求めてください。

製品を持ち上げたり運んだりする作業は慎重に行ってください。本製品には持ち運び用のハンドルが取り付けら

れています
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警告： 本機はかなりの重量があります。怪我をしたり装置が損傷することがないように、製品を持ち運ぶときには
誰かの手を借りてください。

本製品には指定された当社のラック取り付け金具のみを使用してください。

プローブとテスト・リード

プローブやテスト・リードを接続する前に、電源コネクタからの電源コードを適切に接地されたコンセントに接続し
てください。

感電を避けるために、常に指はプローブの指ガードまたは触覚段差より後方に保ってください。

使用しないプローブ、テスト・リード、アクセサリはすべて取り外してください。

測定に使用するプローブ、テスト・リード、アダプタは、測定カテゴリ（CAT）、電圧、温度、高度、アンペア数の定格

が適切なもののみを使用してください。

高電圧に注意： 使用するプローブの電圧定格について理解し、その定格を超えないようにしてください。特に次の

2 つの定格についてはよく理解しておく必要があります。

■ プローブ・チップとプローブの基準リード間の最大測定電圧

■ プローブ基準リードとアース間の最大フローティング電圧

上記の 2 つの電圧定格はプローブと用途によって異なります。詳細については、プローブのマニュアルの仕様関

連セクションを参照してください。

警告： 感電を防止するために、オシロスコープの入力 BNC コネクタ、プローブ・チップ、またはプローブ基準リード
の最大測定電圧や最大フローティング電圧を超えないように注意してください。

接続と切断の手順を守ってください： プローブ出力を測定器に接続してから、プローブを被測定回路に接続してく

ださい。被測定回路にプローブの基準リードを接続してから、プローブ入力を接続してください。プローブ入力とプ
ローブの基準リードを被測定回路から切断した後で、プローブを測定器から切断してください。

プローブの基準リードは、グランドにのみ接続してください。

プローブとアクセサリを検査してください： 使用前には必ずプローブとアクセサリに損傷がないことを確認してくだ

さい（プローブ本体、アクセサリ、ケーブル被覆などの断線、裂け目、欠陥）。損傷がある場合には使用しないでく
ださい。

グランド基準のオシロスコープの使用： グランド基準のオシロスコープで使用する場合、プローブの基準リードは

フローティングさせないでください。基準リードは接地電位（0V）に接続しなければなりません。

フローティング測定の使用： 本プローブの基準リードは、定格フローティング電圧を超えてフローティングさせない

でください。

 安全性に関する重要な情報
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安全に保守点検していただくために

「安全に保守点検していただくために」のセクションには、製品の保守点検を安全に行うために必要な詳細な情報

が記載されています。資格のあるサービス担当者以外は、保守点検手順を実行しないでください。保守点検を行
う前には、この「安全に保守点検していただくために」と「安全にご使用いただくために」をお読みください。

感電を避けるため、： 露出した接続部には触れないでください。

保守点検は単独で行わないでください。： 応急処置と救急蘇生ができる人の介在がない限り、本製品の内部点

検や調整を行わないでください。

電源を切断してください。： 保守点検の際にカバーやパネルを外したり、ケースを開く前に、感電を避けるため、製

品の電源を切り、電源コードを電源コンセントから抜いてください。

電源オン時の保守点検には十分注意してください。： 本製品には、危険な電圧や電流が存在している可能性が

あります。保護パネルの取り外し、はんだ付け、コンポーネントの交換をする前に、電源の切断、バッテリの取り
外し（可能な場合）、テスト・リードの切断を行ってください。

修理後の安全確認。： 修理を行った後には、常にグランド導通と電源の絶縁耐力を再チェックしてください。

本マニュアル内の用語

本マニュアルでは以下の用語を使用しています。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本機やその他の接続機器に損害を与えるおそれのある状態や行為を示します。

本機に関する用語

本機では次の用語を使用します。

■ 危険： ただちに人体や生命に危険をおよぼす可能性があることを示します。

■ 警告： 人体や生命に危険をおよぼす可能性があることを示します。

■ 注意： 本製品を含む周辺機器に損傷を与える可能性があることを示します。

安全性に関する重要な情報
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本製品の記号：

製品にこの記号が表記されているときは、マニュアルを参照して、想定される危険性とそれらを回避す
るために必要な行動について確認してください（マニュアルでは、この記号はユーザに定格を示すため
に使用される場合があります。）

本製品では、次の記号を使用します。

安全性に関する重要な情報
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まえがき

本マニュアルには、製品の安全とコンプライアンス、オシロスコープの接続方法と電源供給方法、機器の機能と制
御と基本操作に関する情報が記載されています。詳細については、製品の Help（ヘルプ）ファイルを参照してくだ

さい。

主な特長

5 シリーズ MSO ロー・プロファイルをお買い求めいただきありがとうございます。5 シリーズ MSO ロー・プロファイ

ル（MSO58LP 型）は、8 チャンネル式のオシロスコープで、入力は世界初の FlexChannel®をベースとしており、実質

的にあらゆる設計において効率的かつ費用効果の高いミックスド・シグナル・デバッキングを実現します。

■ 2U のラック・スペースにそのまま設置できるディスプレイを持たないロー・プロファイル・タイプ

■ 周波数帯域：1GHz、500MHz（アップグレード可能）

■ 8 チャンネル（FlexChannel®入力）

■ 各 FlexChannel 入力にはアナログ・プローブ（TekVPI®または BNC）または 8 チャンネルのデジタル・プローブ

（TLP058 型 FlexChannel 対応ロジック・プローブ）のいずれも接続可能

■ サンプル・レート最大 6.25GS/s

■ すべてのチャンネルにおいて、125M ポイントのレコード長

■ 最大波形取り込みレート 500,000 波形／秒

■ FastFrame™によるセグメント・メモリ・アクイジションでは、複数のトリガ・イベントを使用することで、時間的に
離れたイベントも、アクイジション・メモリの内容を観測しながら、高いサンプル・レートで取り込むことが可能

■ 取り込む演算波形、基準波形、バス波形の設定限度はなし（実際の波形数は使用可能なシステム・メモリに
依存）。

■ 組み込みオプションとして、50MHz の任意関数発生器（AFG）、デジタル・ボルトメータ（DVM）トリガ周波数カウ

ヱタをご用意

■ 拡張シリアル・バス・トリガ／解析オプションを使用することで、さまざまな規格のバスでのデコード／トリガが
可能。「シリアル・バスとトリガ・オプション」のヘルプ・トピックを参照

■ パワー／ジッタ測定オプションを使用することで、さまざまな測定／解析機能を追加可能。「拡張パワー解析」

および「拡張ジッタ解析」オプションのヘルプ・トピックを参照

関連するマニュアル

関連するマニュアルを使用して、機器の機能や機器の遠隔プログラミングおよび遠隔操作方法、操作理論の理
解方法、疑わしいモジュールの交換方法、その他のタスクの実行方法に関する情報を入手してください。
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MSO58LP 型のマニュアル

知りたい情報 使用するマニュアル

機器の機能の使用方法 5 シリーズ MSO（MSO58LP 型）インストールおよび安全性に関するマニュアル（本

書。当社部品番号 071-3568-xx。機器に標準で付属）。英語版、日本語版、簡体字中

国語版の 1 冊のマニュアル。ロシア語版は当社の Web サイトから入手可能（当社部

品番号 077-1404-xx）
5 シリーズ／6 シリーズ MSO のヘルプ（当社部品番号 077-1303-xx。機器の印刷可能

バージョンのヘルプ。www.tektronix.com/downloads より入手可能）

機器を遠隔で操作する方
法

5 シリーズ／6 シリーズ MSO のプログラマ・マニュアル（当社部品番号 077-1305-xx。
www.tek.com/downloads より入手可能）

機器の仕様および機器の
仕様への適合性を確認す
る手順

5 シリーズ MSO の MSO54 型、MSO56 型、MSO58 型、MSO58LP 型の仕様および性能
確認用テクニカル・リファレンス（当社部品番号 077-1306-xx。www.tek.com/downloads
より入手可能）

TLP058 ロジック・プローブ

の使用

TLP058 型 FlexChannel®ロジック・プローブ取扱説明書（当社部品番号 071-3515-xx。
www.tek.com/downloads より入手可能）

作業台で使用するための
機器の変換

MSO58LP 型の作業台変換キット取扱説明書（当社部品番号 075-1102-xx。
www.tek.com/downloads より入手可能）

まえがき  
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本機の設置

同梱アクセサリの確認

注文したものがすべてお手元に届いたことを確認してください。足りないものがある場合には、当社カスタマ・サポ
ートにお問い合わせください。北米：1-800-833-9200 までお電話ください。世界の他の地域では、www.tek.com にアク

セスし、お近くの代理店をお探しください。

本機の付属品一覧を見て、注文品とスタンダード・アクセサリがすべて届いているか確認してください。シリアル・
バスとトリガ・オプション、パワー測定オプションなど工場出荷時実装オプションを購入した場合には、Help（ヘル

プ）> About（概要）をタップして、そのオプションが Installed Options（実装オプション）表に掲載されていることを確

認してください。

MSO58LP 型のスタンダード・アクセサリ

品名 数量 当社部品番号

5 シリーズ MSO（MSO58LP 型）の設置と安全性に関するマニュアル 1 071-3568-xx

電源ケーブル 1 リージョンにより異な
る

校正証明書 1 －

工場出荷時実装ライセンスのレポート 1 －

動作要件

高い測定精度と安全な機器動作を確保するために、動作温度、電力、高度、信号入力電圧の各必須範囲内でこ
のオシロスコープを使用してください。

環境要件

特性 説明

動作温度 0℃～＋ 50℃（＋ 32°F～＋ 122°F）
正しく冷却するために、本機の側面から 2 インチ（51mm）の範囲には障害

物を置かないでください。

動作湿度 ＋ 40℃（＋ 104ﾟF）以下で相対湿度 5%～90%（RH）（結露のない状態）

＋ 40 ℃（＋ 104 ﾟF）～ ＋ 50 ℃（＋ 122 ﾟF）で相対湿度 5% ～ 55%（RH) （結
露のない状態）

動作高度 3,000m（9,842 フィート）以下
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電力要件

特性 説明

電源電圧 100V～240VAC RMS、±10%、単相

電源周波数 50/60Hz、100～240V
400Hz、115V

消費電力 全機種共通：最大 400W

入力信号要件

入力信号を許容制限内に収めることで、正確な測定を確保し、アナログとデジタルのプローブまたは機器への損
傷を防ぎます。

入力信号が以下の要件の範囲内にあることを確認します。

入力 説明

アナログ入力チャンネル、1MΩ 設定、BNC で

最大入力電圧

300VRMS
測定カテゴリ II

アナログ入力チャンネル、50Ω 設定、BNC で

最大入力電圧

5VRMS

デジタル入力チャンネル、デジタル入力で最
大入力電圧レンジ

プローブ定格表記の確認
TLP058 型の場合：±42VP

Ref In（基準入力）：BNC で最大入力電圧（後

部パネル）

7VPP

AUX トリガ入力 ±5VRMS

機器のラックへの設置

MSO58LP 型を標準型の 19"機器ラックに設置する際には、以下の指示に従ってください。

MSO58LP 型はラック固定用金具でシャーシに設置された状態で出荷されます。付属のアクセサリ袋のボルトとワ

ッシャを使用して、ラックにリア・ラック・ブラケットを取り付けます。

作業台で MSO58LP 型を使用するには、MSO58LP 型の作業台変換キット（当社部品番号 020-3180-xx）を購入し、

設置する必要があります。このキットには、シャーシ足とハンドルが入っていて、作業台に本機を置くことができま
す。

次の手順に従って、ラックに本機を設置します。

本機の設置  

2 MSO58LP 型の設置と安全性に関するマニュアル



警告： けがをしないように、本機の設置は 2 人で行ってください。

1. 付属品のボルトとワッシャを 2 組使用して、リア・ラック固定用金具の 1 つをラックの後部に取り付けます。手

で締め付けます。
 

 

2. 2 人で本機を支え、シャーシ・ラック固定用金具がリア・ラック固定用金具に差し込まれるようにラックの前面

から本機を挿入します。

3. 本機がラックの前面と同一平面になるまで前面から押し込み続けます。

4. 付属品のボルトとワッシャを 4 組使用して、本機の前面をラックに取り付けます。手で締め付け、本機を支え

ます。

5. ラックの後部から、リア・ラック固定用金具がリア・ラックと同一平面になるまで 2 番目のリア・ラック固定用金

具を本機のシャーシ・ラック固定用金具にスライドします。

6. 付属品のボルトとワッシャを 2 組使用して、2 番目のリア・ラック固定用金具をラックの後部に取り付けます。

手で締め付けます。

7. 1.1Nm（ニュートン・メータ）まで手で締め付けます。

8. 5/16 インチのレンチを使用して、両側のラック固定用金具アセンブリに付属の六角ボルトを 2 個取り付け、固

定用金具を所定の位置に固定し、前面ラックのネジが外れたときに本機が誤って分離しないようにします（以
下のイメージを参照）。両側に 4 カ所のボルト位置があります（イメージを参照）。0.7Nm（ニュートン・メータ）ま

で固定用金具の固定ボルトを締め付けます。
 

 

9. 必要に応じて後部シャーシに電源コードとケーブルを取り付けます。

ラック・マウントの指示終わり：

 本機の設置
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オシロスコープの固定（ロック）

プロパティの損失を防ぐために、オシロスコープをテスト・ベンチや設備ラックにロックします。

標準的なノートパソコン用セキュリティ・ロックをオシロスコープの後部パネルに取り付けて、オシロスコープを作
業台やラック、その他の場所に固定します。
 

 

オシロスコープへの電源投入

この手順では、オシロスコープをライン電源に接続し、オシロスコープへの電源の投入と遮断を行います。オシロ
スコープを AC 電源に接続する時には必ず、本機に同梱されている電源コードを使用してください。

前提条件：オシロスコープに同梱されている AC 電源コードを使用してください。

1. 付属の電源コードをオシロスコープの電源コネクタに接続します。

図 1 : MSO58LP 型の電源コード・コネクタと電源スタンバイ・スイッチ

2. 電源コードを適切な AC 電源に接続します。

AC 電源コードが導通状態の電源回路に接続されると、電力が電源供給部とその他の基盤に供給され、本機

が Standby（スタンバイ）モードに入ります。

3. 本機の電源をオンまたはオフにするには、前面パネルの電源ボタンを押します。

電源ボタンの色は本機の電源ステータスを示します：

無灯–AC 電力が投入されていない

黄色–Standby（スタンバイ）モード

青色–電源オン

4. 本機の電源を完全に切るには、電源コードを抜きます。

本機の設置  
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パワーオン・セルフ・テストでのオシロスコープの合格の確認

パワーオン・セルフ・テストでは、オシロスコープの全機種が起動後に正常に作動するかを確認します。

前提条件：MSO58LP 型では、モニタを後部パネルのビデオ出力に接続し、マウスを USB ポートに接続します。

1. オシロスコープの電源を入れて、オシロスコープのスクリーンに表示が出るまで待ちます。

2. 上端のメニュー・バーで Utility（ユーティリティ）> Self Test（セルフ・テスト）を選択し、Self Test（セルフ・テスト）

のコンフィグレーション・メニューを開きます。

3. すべてのパワーオン・セルフ・テストのステータスが Passed（合格）になっていることを確認します。

いずれかのパワーオン・セルフ・テストの結果が Failed（不合格）と表示されている場合：

a. オシロスコープの電源を入れ直します。

b. Utility（ユーティリティ）> Self Test（セルフ・テスト）をタップします。それでもいずれかのパワーオン・セル

フ・テストの結果が Failed（不合格）と表示される場合には、当社カスタマ・サポートに問い合わせてくださ

い。

プローブの接続

プローブとケーブルを使ってオシロスコープを被測定装置（DUT）に接続します。プローブは信号測定のニーズに

最適なものを使用してください。

図 2 : MSO58LP 型へのプローブの接続

TPP0500 型、TPP1000 型、TekVPI+、TekVPI、またはサポートされているその他の当社アナログ・プローブを

FlexChannel コネクタに挿入して接続します。プローブは完全に挿入されると、プローブのベース・ラッチがカチッと

音を立ててロックされます。

本機の設置
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TekVPI プローブについては、このプローブのチャンネル入力パラメータ（帯域幅、減衰比、ターミネーションなど）

が自動で設定されます。プローブに Menu（メニュー）ボタンがある場合、そのボタンを押してスクリーン上のコンフ

ィグレーション・メニューを開きます。アクティブなプローブの取扱説明書に従ってパラメータ（自動ゼロ、デガウス
など）を設定します。

TLP058 型 FlexChannel ロジック・プローブまたは TDP7700 シリーズ TriMode™プローブを接続するには、以下の手

順を実行します。

1. ロック・レバーをアンロック位置に移動させ、ロック・レバーが中央に戻るまで待ちます。

2. FlexChannel コネクタにプローブを挿入し、プローブが完全に挿入されてロック・メカニズムのカチッという音が

するまで押し込みます。

3. ロック・レバーをロック位置に移動させます。ステータス・ライトが緑色に点灯します。

4. TLP058 プローブを取り外すには、ロック・レバーをアンロック位置に移動させたままプローブを引き抜きます。

プローブを取り外している時にリボン・ケーブルを引っ張らないでください。

BNC のプローブまたはケーブルをチャンネル BNC 差し込みコネクタに挿入して接続し、ロック・メカニズムをロック

されるまで時計回りに回します。

注： プローブを接続しても、そのチャンネルは自動的に有効にはなりません（アクティブにしてください）。プローブ
またはケーブルの設定（帯域幅、減衰、ターミネーションなど）の確認や変更を行うには、Channel（チャンネル）バッ
ジをダブルタップしてそのコンフィグレーション・メニューを開きます。

本機の設置
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機器の詳細

MSO58LP 型の前面パネル・コントロールとコネクタ

前面パネルでは、本機の電源オン／オフ、プローブまたはケーブルを使用して信号を接続、外部トリガの入力信
号を接続、USB デバイスの装着、プローブ補正信号のアクセスを行います。
 

 

1. FlexChannel®プローブ・コネクタ：

FlexChannel®コネクタは、TekVPI+測定プローブ、TekVPI 測定プローブ、BNC 受動プローブ、TLP058 型

FlexChannel®ロジック・プローブ、BNC ケーブルのすべてに対応しています。プローブの接続は簡単で、プロー

ブをカチッと音がするまでしっかりとコネクタに押し込むだけです。プローブの接続(5 ページ)を参照

2. LAN ステータス LED：

ネットワーク接続とアクティビティ・ステータスを示します：

■ オフ－本機に電力が供給されていない

■ 緑－ネットワーク接続良好

■ 赤－ネットワーク接続不良または未接続
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3. プローブ補正コネクタ：
 

 

プローブ補正用接続部には、グランド・コネクタと 1kHz の方形波ソースがあり、受動プローブの高周波数応答

の調整（プローブ補正）に使用します。オシロスコープはこの信号を利用して、サポートされているプローブの
自動補正を行います。TPP0500B 型プローブまたは TPP1000 型プローブの補正(13 ページ) を参照してくださ

い。

グランド・コネクタを使用して、帯電防止用リスト・ストラップを付けて、DUT を扱うまたは試験する際の静電気

損傷（ESD）の可能性を低減することも可能です。

4. USB ホスト・ポート：

USB ポートは前面パネルの右下にあります。データ（機器のファームウェア更新、波形、設定、スクリーン・キ

ャプチャなど）の保存やリコールが可能な USB フラッシュ・ドライブを接続するか、またはマウスやキーボード

などの周辺機器を接続してください。

5. Aux Trig トリガ入力コネクタ：

外部トリガの入力信号を接続できる SMA コネクタ。AUX In トリガ信号はエッジ・トリガ・モードを指定して使用し

ます。

6. Acq ステータス LED：

本機のトリガ／アクイジション・ステータスを示します：

■ 緑－トリガされている

■ 黄色－待機状態だがまだトリガされていない

■ 赤－アクイジション停止

7. 電源オン／スタンバイ・ボタン：

本機の電源をオン／オフにします。電源ボタンの色は本機の電源ステータスを示します：

■ 無灯–AC 電力が投入されていない

■ 黄色–Standby（スタンバイ）モード

■ 青色–電源オン

機器の詳細  
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後部パネルの接続部

後部パネルの接続部は、オシロスコープへの電源供給と、ネットワーク、USB デバイス、ビデオ、リファレンス信

号、AFG 出力の接続のために使用します。
 

 

1. 電源コード・コネクタ：本製品用に指定され、使用される国で認定された電源コードのみを使用してください。

2. Ref In：高精度 10MHz リファレンス信号をオシロスコープに接続して測定の精度を確保します。

3. AUX Out：トリガ・イベントで信号トランジションを生成し、10MHz のリファレンス信号を出力、または AFG から同

期信号を出力します。

4. AFG Out：オプションの任意波形／ファンクション・ジェネレータ（AFG）用の信号出力です。

5. ビデオ出力（Display Port、VGA、DVI-D）：外部のモニタまたはプロジェクタに接続してオシロスコープの画面を表

示します。

6. USB デバイス・ポート：USBTMC プロトコルを使用してオシロスコープを遠隔操作する場合に PC に接続しま

す。

7. USB ホスト・ポート：USB メモリ・デバイス、キーボード、またはマウスを接続します。

8. LAN コネクタ（RJ-45）：オシロスコープを 10/100/1000 Base-T ローカル・エリア・ネットワークに接続します。

9. セキュリティ・ロック・コネクタ：標準的な PC/ノートパソコン用ロック・ケーブルを使用して、オシロスコープを作

業台やその他の場所に固定します。

 機器の詳細
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グラフィカル・ユーザ・インタフェース

MSO58LP 型はプログラム制御用に設計されていますが、製品のヘルプ・トピックを組み込んだグラフィカル・ユー

ザ・インタフェースも備えています。モニタとマウスを機器に接続するか、ブラウザを使用してネットワーク接続され
た機器にアクセスすることによってグラフィカル・インタフェースにアクセスできます。

最小解像度 1,920（水平）×1,080（垂直）ピクセル（高品位）のモニタ（標準またはタッチスクリーン）を後部パネルの

ビデオ出力コネクタに接続します。

ブラウザからアクセスするには、機器の IP アドレスをブラウザのアドレス・フィールドに入力し、機器のブラウザの

ようこそページを開きます。スクリーンの左側にある Instrument Control（機器制御）（e*Scope®）リンクをクリックし、グ

ラフィカル・インタフェースを開きます。

マウス（USB ケーブル）またはマウス・ドングル（ワイヤレス USB マウス用）を任意の USB ポートに接続します。

グラフィカル・ユーザ・インタフェースの概要と使用法について詳しくは、『5 Series MSO (MSO54, MSO56, MSO58)
Installation and Safety Manual』（5 シリーズ MSO（MSO54 型、MSO56 型、MSO58 型）の設置と安全性に関するマニュア

ル：当社部品番号 071-3514-xx）を参照してください。このマニュアルは www.tek.com/product-support からダウンロー

ドできます。

機器の詳細  
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本機の設定

タイム・ゾーンとクロック・リードアウト・フォーマットの設定

保存したファイルに正しい日時情報がマークされるように、お住いの地域にタイム・ゾーンを合わせます。また、タ
イム・フォーマット（12 時間クロックまたは 24 時間クロック）も設定できます。

MSO58LP 型でユーザ・インタフェースにアクセスするには、本機後部のビデオ・ポートにモニタを接続し、任意の

USB ホスト・ポートにマウスを接続します。リモート・モニタがタッチ操作に対応している場合、マウスを接続する必

要はありません。Web ブラウザに機器の IP アドレスを入力して、ネットワーク接続された機器のユーザ・インタフェ

ースにリモート・アクセスすることもできます。

MSO58LP 型でこのコントロールをリモート設定するまたはこのタスクを実行するために使用する正しいコマンドに

ついては、オシロスコープ・プログラマ・マニュアル（当社部品番号 077-1305-xx）を参照してください。

1. 画面右下にある Date/Time（日時）バッジをダブルタップしてコンフィグレーション・メニューを開きます。
 

 

2. 画面上の日時を非表示にするには、Display（表示）ボタンをタップして Off（オフ）にします。

日時を再び表示するには、日時バッジが表示されていた部分の空白のエリアをダブルタップしてコンフィグレ
ーション・メニューを開き、Display（表示）ボタンを On（オン）にします。

3. タイム・フォーマット（12 Hour（12 時間）または 24 Hour（24 時間））を選択します。

4. Time Zone（タイム・ゾーン）フィールドをタップして適切なタイム・ゾーンを選択します。

5. メニューの外の任意の部分をタップしてメニューを閉じます。

最新ファームウェアのダウンロードおよびインストール

最新のファームウェアをインストールしておくと、オシロスコープによる測定の高い精度を維持するのに役立ちま
す。

MSO58LP 型でユーザ・インタフェースにアクセスするには、本機後部のビデオ・ポートにモニタを接続し、任意の

USB ホスト・ポートにマウスを接続します。リモート・モニタがタッチ操作に対応している場合、マウスを接続する必

要はありません。Web ブラウザに機器の IP アドレスを入力して、ネットワーク接続された機器のユーザ・インタフェ

ースにリモート・アクセスすることもできます。
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USB ドライブ経由のオシロスコープ・ファームウェアの更新

前提条件：必ず、オシロスコープにインストールされているファームウェアの現在のバージョンを確認しておいてく
ださい（Help（ヘルプ）> About（概要））。

1. PC で Web ブラウザを起動して、www.tek.com/product-support にアクセスします。

2. 検索フィールドにオシロスコープの型名を入力して Go をクリックします。

3. スクリーンを下スクロールし、Software（ソフトウェア）タブをクリックします。

4. 掲載されている入手可能なファームウェア・バージョン（Windows 版または非 Windows 版）が、お使いのオシロ

スコープのものよりも新しい場合には、そのファイルを選択して PC にダウンロードしてください。

5. ダウンロードしたファームウェアに付属するインストール方法の説明に従って、ファームウェア・インストール・
ファイルを作成します。

6. ファームウェア・インストール・ファイルを USB ドライブにコピーします。

7. USB ドライブをオシロスコープのいずれかの USB ホスト・ポートに差し込みます。

a. 非 Windows 版のオシロスコープでは、ファームウェア・ファイルが保存されている USB ドライブを検出して

インストール処理を開始します。画面の指示に従ってファームウェアをインストールします。

b. Windows 版のオシロスコープでは、ファームウェアを更新する前に TekScope プログラムを閉じます。

Explorer を開いて、USB ドライブに格納されたファームウェア更新ファイルを実行します。または、ファーム

ウェア更新ファイルをデスクトップにコピーし、そこからファイルを実行します。画面の指示に従ってファー
ムウェアをインストールします。

注： ファームウェアのインストールが完了するまでは、オシロスコープの電源を切ったり、USB フラッシュ・ドラ
イブを取り外したりしないでください。オシロスコープの電源を切ってよい時期を知らせるメッセージがオシロ
スコープに表示されます。

8. ファームウェアのインストールが完了したら、USB ドライブを取り外し、オシロスコープを再起動します。

ファームウェアが正しくインストールされたことを確認するには、メニュー・バーから

a. Help（ヘルプ）> About（概要）をタップします。

b. 画面に表示されているファームウェア・バージョン番号が、ダウンロードしたバージョンの番号と同じであ
ることを確認します。

信号経路補正（SPC）の実行

高い測定精度を確保するために定期的に SPC を実行してください。周囲（室内）温度が 5℃（9°F）以上変化した場

合は必ず SPC を実行してください。また、5mV/div 以下の垂直軸スケール設定を使用する場合にも、週に一度、

SPC を実行してください。

MSO58LP 型でユーザ・インタフェースにアクセスするには、本機後部のビデオ・ポートにモニタを接続し、任意の

USB ホスト・ポートにマウスを接続します。リモート・モニタがタッチ操作に対応している場合、マウスを接続する必

要はありません。Web ブラウザに機器の IP アドレスを入力して、ネットワーク接続された機器のユーザ・インタフェ

ースにリモート・アクセスすることもできます。

MSO58LP 型でこのコントロールをリモート設定するまたはこのタスクを実行するために使用する正しいコマンドに

ついては、オシロスコープ・プログラマ・マニュアル（当社部品番号 077-1305-xx）を参照してください。

信号経路補正（SPC）は、周囲温度の変化や長期ドリフトによって生じる内部信号経路の DC レベルの確度の誤

差を修正します。SPC を定期的に実行しない場合、低い V/div 設定で保証されているオシロスコープ性能を得られ

ない可能性があります。

本機の設定  
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前提条件：必ず、前面パネルのチャンネル入力とリアパネルの信号コネクタからプローブとケーブルをすべて取り
外してください。

1. オシロスコープの電源をオンにし、20 分以上ウォーム・アップします。

2. Utility（ユーティリティ）> Calibration（校正）をタップします。

3. Run SPC（SPC の実行）をタップします。SPC の実行中は、SPC Status（SPC ステータス）のリードアウトに

Running（実行中）と表示されます。1 チャンネルあたりの SPC の実行には数分かかる場合があるため、SPC
ステータスのメッセージが Pass（合格）に変わるまで待ってから、プローブを再接続してオシロスコープを使用

するようにしてください。

注意： Abort SPC（SPC の中止）をタップすれば SPC 校正を中止できます。中止するとチャンネルは未補正の
ままとなる可能性があり、その場合は測定の精度が下がるおそれがあります。SPC を中止する場合には必
ず、本機を使用して測定を実施する前に SPC 手順を完全に実行してください。

4. SPC が完了したら Calibration（校正）コンフィグレーション・ダイアログを閉じます。

5. SPC に失敗した場合にはエラー・メッセージ・テキストを書き留めておいてください。プローブとケーブルがす

べて取り外されていることを確認し、SPC をもう一度実行します。それでも SPC に失敗した場合には、当社カ

スタマ・サポートに問い合わせてください。

TPP0500B 型プローブまたは TPP1000 型プローブの補正

高度な波形取り込みと高精度の測定を確保するために、プローブ補正によりプローブの高周波応答を調整しま
す。本オシロスコープでは、プローブとチャンネルの無数の組み合わせに対する補正値の試験と保存を自動で実
行できます。

MSO58LP 型でユーザ・インタフェースにアクセスするには、本機後部のビデオ・ポートにモニタを接続し、任意の

USB ホスト・ポートにマウスを接続します。リモート・モニタがタッチ操作に対応している場合、マウスを接続する必

要はありません。Web ブラウザに機器の IP アドレスを入力して、ネットワーク接続された機器のユーザ・インタフェ

ースにリモート・アクセスすることもできます。

MSO58LP 型でこのコントロールをリモート設定するまたはこのタスクを実行するために使用する正しいコマンドに

ついては、オシロスコープ・プログラマ・マニュアル（当社部品番号 077-1305-xx）を参照してください。

本オシロスコープでは、プローブとチャンネルの組み合わせごとに補正値が保存され、プローブを接続すると自動
で補正値が呼び出されます。Channel（チャンネル）コンフィグレーション・メニューの Probe Setup（プローブ・セットア

ップ）パネルには、プローブ補正ステータスが表示されます。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Pass（合格）と表示されている場合、そのプロ

ーブは補正されており使用可能な状態です。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Default（デフォルト）と表示されている場合、

取り付けたプローブはまだ補正されていないため、このプローブ補正手順を実行する必要があります。

■ Probe Compensation Status（プローブ補正ステータス）フィールドに Fail（不合格）と表示されている場合、取り付

けたプローブへのプローブ補正手順が失敗しています。そのプローブを接続し直して、もう一度プローブ補正
を実行してください。

■ パネルにプローブ補正ステータス・フィールドが表示されていない場合は、このオシロスコープではそのプロ
ーブの補正値を保存できません。本オシロスコープの Help（ヘルプ）から、プローブ補正機能にサポートされ

ていない受動プローブを手動で補正する方法を確認してください。

TPP0500B 型プローブ、TPP1000 型プローブ、またはサポートされているその他の TPP シリーズのプローブをこの

オシロスコープに接続するとステータスが Default（デフォルト）と表示された場合に、この手順を用いてプローブの

補正を行います。

 本機の設定
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注： Default Setup（デフォルト・セットアップ）によりプローブ補正値が消去されることはありません。工場校正では
保存されたプローブ補正値がすべて消去されます。

前提条件：プローブ補正を行う時には必ず、オシロスコープに電源を入れて少なくとも 20 分間待ってから補正を

開始してください。

1. サポートされているプローブを入力チャンネルに接続します。

2. プローブ・チップとそのプローブのグランド・リードを、オシロスコープの右下 にある PROBE COMP（プローブ補

正）端子に接続します（下図を参照）。

図 3 : MSO58LP 型でのプローブ補正の接続

プローブ・チップを 1kHz ソースに接続し、グランド・クリップをグランドに接続します。最良の結果を得るため

に、プローブ・チップのアクセサリをすべて取り外し、プローブ・チップを 1kHz コネクタに直接取り付けます。

注： PROBE COMP（プローブ補正）端子に同時に複数のプローブを接続することはできません。

3. すべてのチャンネルをオフにします。

4. プローブが接続されているチャンネルをオンにします。

5. MSO58LP 型では、メニュー・バーから File（ファイル） > Autoset（オートセット）を選択します。スクリーンに方形

波が表示されます。

6. 補正するチャンネルのバッジをダブルタップします。

7. Probe Setup（プローブ・セットアップ）パネルをタップします。

Probe Compensation Status（プローブ補正ステータス）に Pass（合格）と表示されている場合、そのプローブはこ

のチャンネルに対してすでに補正されています。このプローブを別のチャンネルに移動させてステップ 1 から

もう一度始めるか、または別のプローブをこのチャンネルに接続してステップ 1 から始めることができます。

Probe Compensation Status（プローブ補正ステータス）に Default（デフォルト）と表示されている場合はそのまま

この手順を続けます。

8. Compensate Probe（プローブの補正）をタップして Probe Compensation（プローブ補正）ダイアログを開きます。

9. Compensate Probe（プローブの補正）をタップしてプローブ補正を実行します。

10. Probe Compensation Status（プローブ補正ステータス）に Pass（合格）と表示されたら、プローブ補正は完了で

す。PROBE COMP（プローブ補正）端子からプローブ・チップとグランドを取り外します。

本機の設定  
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11. 上記ステップを繰り返して、サポートされているそれぞれの受動プローブをこのチャンネルに対して補正しま
す。

12. 上記ステップを繰り返して、サポートされている受動プローブをこのオシロスコープのその他のチャンネルに
対して補正します。

注： 高精度の測定を実現するために、プローブをチャンネルに取り付けたときには、Probe Setup（プローブ・セ
ットアップ）パネルを開いて、Probe Compensation Status（プローブ補正ステータス）に Pass（合格）と表示されて
いるかを確認してください。

ネットワークヘの接続（LAN）
ネットワークに接続すると、本機への遠隔アクセスが可能になります。

MSO58LP 型でユーザ・インタフェースにアクセスするには、本機後部のビデオ・ポートにモニタを接続し、任意の

USB ホスト・ポートにマウスを接続します。リモート・モニタがタッチ操作に対応している場合、マウスを接続する必

要はありません。Web ブラウザに機器の IP アドレスを入力して、ネットワーク接続された機器のユーザ・インタフェ

ースにリモート・アクセスすることもできます。

ネットワーク管理者と協力して、ネットワーク接続に必要な情報（IP アドレス、ゲートウェイ IP アドレス、サブネット・

マスク、DNS IP アドレスなど）を取得します。

1. オシロスコープの LAN コネクタの CAT5 ケーブルをネットワークに接続します。

2. メニュー・バーの Utility（ユーティリティ）> I/O（入出力）を選択して入出力コンフィグレーション・メニューを開き

ます。

3. ネットワーク・アドレスの情報を取得または入力します。

■ DHCP が有効なネットワークの場合は、Auto（自動）をタップすると、ネットワークから IP アドレス情報を取

得できます。デフォルトのモードは DHCP モードです。

■ DHCP 対応ネットワークではない場合、または本機に永続（固定）IP アドレスが必要な場合には、Manual
（手動）をタップして、IT 担当者またはシステム管理者から取得した IP アドレスなどの値を入力します。

4. Test Connection（テスト接続）をタップしてネットワーク接続が機能していることを確認します。本機がネットワ

ークに正常に接続されている時には LAN ステータス・アイコンが緑色に点灯します。ネットワークの接続に問

題がある場合、システム管理者に問い合わせてください。

MSO58LP 型の前面パネルには、ネットワークのステータスを表す LAN ステータス LED があります。

■ オフ－本機に電力が供給されていない

■ 緑－ネットワーク接続良好

■ 赤－ネットワーク接続不良または未接続

本機の設定
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Web ブラウザからのリモート・アクセス

Web ブラウザを使用して、ネットワークに接続された（Windows 10 を実行していない）標準型の計測器にリモート・

アクセスし、PC 上に本機のユーザ・インタフェースを表示できます。

以下の手順では、（Windows 10 版ではない）標準型の計測器の UI コントロールやスクリーンにリモート・アクセスを

する方法について説明します。Windows 10 バージョンの UI コントロールおよびスクリーンにリモート・アクセスする

には、

前提条件：

■ オシロスコープは、その PC が接続されているネットワークに接続されており、そのネットワークからアクセス

できる状態でなければなりません。ネットワークヘの接続（LAN）(15 ページ)を参照してください。

■ アクセスするオシロスコープの IP アドレスを確認しておきます。オシロスコープの IP アドレスを確認するに

は、オシロスコープのメニュー・バーから Utility（ユーティリティ）> IO（入出力）を選択し、LAN パネルのネットワ

ーク設定を確認します。

■ （Windows 10 オプションがインストールされていない）標準型の計測器にアクセスするには、以下の手順を実

行します。

1. オシロスコープと同じネットワークに接続されている PC 上で Web ブラウザを開きます。

2. ブラウザの URL ラインにオシロスコープの IP アドレスを入力して Enter キーを押します。たとえば、

「135.62.88.157」のように入力します。ブラウザでオシロスコープの Web ページを検索して開きます。

3. Instrument Control (e*Scope®)（機器の管理）を選択します。ブラウザに本機のスクリーンが表示されます。

4. マウスを使用して、Web ブラウザに表示されているオシロスコープ・コントロールを選択してインタラクティブ操

作を行います。リモート PC またはノートパソコンにタッチ・スクリーン・モニタがある場合、そのモニタを使用し

てオシロスコープ・コントロールにアクセスできます。

注： e*Scope ブラウザから本機にアクセスするときは、PC からテキスト（パス、IP アドレス情報など）を機器のメ
ニュー・フィールドに直接貼り付けることはできません。この場合、e*Scope アプリケーションのクリップボード機
能を介在させる必要があります。

e*Scope で接続された PC から機器にテキストをコピーするには、以下の手順を実行します。

a. e*Scope を使用して、機器との接続を開きます。

b. PC 上でテキストを選択し、コピーします。

c. e*Scope で Ctrl-Alt-Shift を押して、クリップボードメニューを開きます。

d. テキストをクリップボード・フィールドに貼り付けます。

e. Ctrl-Alt-Shift を押して、ブラウザのクリップボード・メニューを閉じます。

f. e*Scope を使用して貼り付け先の機器のメニューを開き、テキストを貼り付けたいフィールドにカーソルを
移動します。

g. （物理的キーボードまたは仮想キーボードで）Ctrl-V を押して、e*Scope ブラウザのクリップボードからメニ
ュー・フィールドにテキストを貼り付けます。

h.  4.b～ 4.g の手順を繰り返して、他のテキストについても PC から機器へとコピー／貼り付けを行います。

本機の設定
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基本操作

グラフィカル・ユーザ・インタフェースを使用してトリガをオンにし、波形を取り込み、測定を行う方法について詳しく
は、『5 Series MSO (MSO54, MSO56, MSO58) Installation and Safety Manual』（5 シリーズ MSO（MSO54 型、MSO56 型、

MSO58 型）の設置と安全性に関するマニュアル：当社部品番号 071-3514-xx）を参照してください。

機器を遠隔操作するために使用する正しいコマンドについては、『 5Series MSO MSO54, MSO56, MSO58, MSO58LP
Programmer Manual』（5 シリーズ MSO（MSO54 型、MSO56 型、MSO58 型、MSO58LP 型）のプログラマ・マニュアル：

当社部品番号 077-1305-xx）を参照してください。

どちらのマニュアルも www.tek.com/product-support からダウンロードできます。
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メンテナンス

このセクションでは、機器の定期的なメンテナンスに必要な情報について説明します。

注意： 破損時にカバーを交換するとき以外は、上部カバーを機器から取り外さないでください。機器内にはユーザ
が交換できる部品はありません。修理が必要な場合は機器を当社までご返送ください。

クリーニング

機器の外部の清掃には、乾いた柔らかい綿布を使用してください。汚れが落ちない場合は、75%のイソプロピル・

アルコール溶液をしみ込ませた布または綿棒を使用してください。コントロールやコネクタの周りの狭い部分のク
リーニングには、綿棒を使用してください。化学洗浄剤は使用しないでください。ケース、コントロール類、マーキン
グやラベルが損傷したり、ケースの中に染み込む恐れがあります。

性能検査の実施間隔と調整

機器内部の電圧およびタイミング・リファレンスはきわめて安定しているため、定期的な調整を行う必要はありま
せん。

要件として定期的な校正が欠かせない環境でご使用の場合には、原則として、機器を 2,000 時間使用するごと

に、あるいは使用頻度が高くない場合には年に 1 回、性能検証を実施してください。オンラインで利用可能な仕様

および性能検査マニュアル（www.www.tek.com/product-support）に記載された手順に従って実施してください。

『仕様および性能検査マニュアル』に記載された性能テストにパスしない場合には、機器の調整が必要な場合が
あります。調整は当社サービス・センターによってのみ実施できます。当社サービス・センターの連絡先について
は、このマニュアルの巻頭の著作権情報のページを参照してください。

交換部品リスト

このセクションでは、ご使用の機器の交換できる部品について説明します。該当するセクションのリストを使用して
交換部品を特定し、交換部品を注文してください。

スタンダード・アクセサリ

本製品のスタンダード・アクセサリは、ユーザ・マニュアルの冒頭部に記載されています。

交換部品

以下の図はユーザ自身による交換が可能な MSO58LP 型の部品を示しています。機器内にはユーザが交換でき

る部品はありません。
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図 4 : 交換部品ダイアグラム
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表 1 : 交換部品リスト

インデック
ス番号

当社部品番号 数量 名称と説明

1 407-6088-xx 2 ブラケット、前面、ラック・マウント、ラック・イヤー（2U）
2 211-1682-xx 14 ネジ、10-32 X 5/16 ボタン・ヘッド、キャップ、黒

3 407-6089-xx 2 ブラケット、後部、ラック・マウント、シャーシ側

4 407-6090-xx 2 ブラケット、後部、ラック・マウント、ラック側

5 020-3180-xx 1 ベンチ変換キット（オプショナル・アクセサリ）

上図にはなし。

A0 1 北米仕様電源プラグ（115V、60Hz）
A1 1 ユニバーサル欧州仕様電源プラグ（220V、50Hz）
A2 1 イギリス仕様電源プラグ（240V、50Hz）
A3 1 オーストラリア仕様電源プラグ（240V、50Hz）
A5 1 スイス仕様電源プラグ（220V、50Hz）
A6 1 日本仕様電源プラグ（100V、50/60Hz）
A10 1 中国仕様電源プラグ（50Hz）
A11 1 インド仕様電源プラグ（50Hz）
A12 1 ブラジル仕様電源プラグ（60Hz）

 メンテナンス
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EMC、安全、環境に関する適合性

適合性に関する情報

このセクションでは、本製品が適合している EMC 基準、安全基準、および環境基準について説明します。この製

品は専門家および訓練を受けた人のみが使用することを目的としています。家庭での使用や子供による使用に
対応して設計されていません。

以下の適合性に関するご質問は、以下の住所宛に、直接お問い合わせいただくこともできます：

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC 適合性

欧州 EMC 指令

指令 2014/30/EU 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載の以下の基準

に準拠します。

EN 61326-1、EN 61326-2-1. 測定、制御、および実験用途の電子機器を対象とする EMC 基準：  1 2 3 4

■ CISPR 11：グループ 1、クラス A、放射および伝導エミッション

■ IEC 61000-4-2：静電気放電イミュニティ

■ IEC 61000-4-3：RF 電磁界イミュニティ  5

■ IEC 61000-4-4：電流高速トランゼント／バースト・イミュニティ

■ IEC 61000-4-5：電力線サージ・イミュニティ

■ IEC 61000-4-6：伝導 RF イミュニティ

■ IEC 61000-4-11：電圧低下と瞬時停電イミュニティ

EN 61000-3-2. AC 電源ライン高調波エミッション

EN 61000-3-3. 電圧の変化、変動、およびフリッカ

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。
2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。
3 機器にテスト・リードまたはテスト・プローブが接続されているときには、これらのリード／プローブに電磁干渉がカップリングされるため、ここに記載

されている標準により規定されたイミュニティ要件を満たせるとは限りません。電磁干渉による影響を最小限に抑えるには、信号の非シールド部分
と対応するリターン・リードの間のループ領域を最小にします。また、電波障害の発生源からできるだけ遠ざけるようにします。ループ領域を少なくす
るための効率的な方法は、非シールド部分のテスト・リードをツイストペアにすることです。プローブの場合、グランド・リターン・リードをできるだけ短く
し、プローブ本体に近づけるようにします。そうした処置を効率的に行えるように、プローブによっては、アクセサリとしてプローブ・チップ・アダプタが
提供されている機種もあります。いずれの場合も、使用するプローブまたはリードの取扱説明書を十分に読むようにしてください。

4 ここに挙げた各種 EMC 規格に確実に準拠するには、ケーブル・シールドとコネクタ・シェルを低インピーダンスで接続できるように、高品質なシール

ドを持つインタフェース・ケーブルが必要です。
5 IEC 61000-4-3 に規定の RF 電磁界／伝導性 RF の干渉を受けた場合、本機器は 10mV/div～1V/div で 0.1div 以下の波形変位および 0.2div 以下の p-p

ノイズ増加を生じます。
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EMC 適合性

仕様表の記載製品と共に使用した場合は、指令 2014/30/EU 電磁環境両立性に適合します。記載製品の公開

EMC 仕様を参照してください。その他の製品と共に使用した場合、指令に適合しない可能性があります。

オーストラリア／ニュージーランド適合宣言―EMC
ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

■ EN 61326-1 および EN 61326-2-1：グループ 1、クラス A、放射および伝導エミッション

安全性

このセクションでは、製品が適合している安全規格およびその他の基準について説明します。

EU 適合宣言 - 低電圧

『Official Journal of the European Union』にリストされている次の仕様に準拠します。

低電圧指令 2014/35/EU：

■ EN 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ EN 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路および

測定回路の特定要求事項。

米国の国家認定試験機関のリスト

■ UL 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ UL 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路および

測定回路の特定要求事項。

カナダ規格

■ CAN/CSA-C22.2 No. 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要

件。

■ CAN/CSA-C22.2 No. 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：

試験回路および測定回路の特定要求事項。

その他の基準に対する適合性

■ IEC 61010-1： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 1 部：一般要件。

■ IEC 61010-2-030： 測定、制御、および実験用途の電子装置に対する安全基準 – 第 2-030 部：試験回路および

測定回路の特定要求事項。

機器の種類

テスト機器および計測機器。

安全クラス

クラス 1 － アース付き製品

EMC、安全、環境に関する適合性  
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汚染度について

製品内部およびその周辺で発生する可能性がある汚染度の尺度です。通常、製品の内部環境は外部環境と同
じ規定が適用されるものとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

■ 汚染度 1：汚染なし、または乾燥した非伝導性の汚染のみが発生します。このカテゴリの製品は、通常、被包

性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

■ 汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が発生

することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露は製品非
動作時のみ発生します。

■ 汚染度 3：伝導性のある汚染、または結露のために伝導性のある汚染となる乾燥した非伝導性の汚染。これ

らは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直接の曝露か
らは保護されている領域です。

■ 汚染度 4：伝導性のある塵、雨、または雪により持続的に伝導性が生じている汚染。これは一般的な屋外環

境に相当します。

汚染度

汚染度 2（IEC 61010-1 の定義による）注：乾燥した屋内でのみ使用できます。

IP 定格

IP20（IEC 60529 で定義）。

測定および過電圧カテゴリについて

本製品の測定端子は、測定する電源電圧について次の 1 つまたは複数のカテゴリに評価されます（製品やマニ

ュアルへの特定の評価を参照）。

■ 測定カテゴリ II：低電圧インストレーションに直接接続された回路で実施する測定用。

■ 測定カテゴリ III：建築物の屋内配線で実施する測定

■ 測定カテゴリ IV：低電圧電源を使用して実施する測定

NOTE. 過電圧カテゴリ定格に該当するのは主電源回路のみです。測定カテゴリ定格に該当するのは測定回路の
みです。製品内部のその他の回路にはいずれの定格も該当しません。

主電源過電圧カテゴリ定格

過電圧カテゴリ II（IEC 61010-1 の定義による）

環境基準に対する適合性

このセクションでは本製品が環境におよぼす影響について説明します。

有害物質に関する規制

RoHS2 指令 2011/65/EU に適合。

 EMC、安全、環境に関する適合性
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使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル. 本製品の製造には天然資源が使用されています。この製品には、環境または人体に有害とな

る可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があります。有害物質の
放出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底にご協力ください。

このマークは、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する指令 2012/19/EC およ

び 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。リサイクル方法について

は、当社の Web サイトのサービス・セクション（www.tek.com/productrecycling）を参照してください。

バッテリのリサイクル

本製品には小型のリチウム・メタル・ボタン電池が内蔵されています。使用済み電池の廃棄については、お住ま
いの地域の所轄官庁にお尋ねください。

過塩素酸塩の取り扱い. 本製品には CR リチウム電池が搭載されています。CR リチウム電池はカリフォルニア州

法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細については、www.dtsc.ca.gov/
hazardouswaste/perchlorate を参照してください。

バッテリの輸送

本機に含まれる小型リチウム一次ボタン電池のリチウム金属の含有量はセルあたり 1g を超えていません。ま

た、メーカによりセルの種類が表記されており、UN Manual of Tests and Criteria Part III, Sub-section 38.3 の該当する要

件を満たしています。リチウム・バッテリの輸送に際しては、その輸送手段に関わらず、製品を発送する前に、再
パッケージ化やラベルの張替えなど、お客様の梱包方法に適用される輸送要件について、運送業者に確認する
ようにしてください。

EMC、安全、環境に関する適合性 
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Aux Trig トリガ入力, 7

D
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F
FlexChannel 入力, 7

L
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LAN ステータス LED, 7
LAN ポート（後部パネル）, 9
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Power standby（電源スタンバイ）モード, 4
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SPC（信号経路補正）, 12
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た
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ディスプレイ・ポート・ビデオ出力（後部パネル）, 9

ね
ネットワーク、接続, 15
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プローブ補正コネクタ, 7
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重要安全信息

本手册包含用户必须遵守的信息和警告，以确保安全操作并保证产品安全。

若要安全执行关于本产品的服务，请参阅常规安全概要后面的服务安全概要。

常规安全概要

请务必按照规定使用产品。详细阅读下列安全性预防措施，以避免人身伤害，并防止损坏本产品或与本产品

连接的任何产品。认真阅读所有说明。保留这些说明以供日后参考。

应根据当地和相应国家法规的要求使用本产品。

为了正确、安全地操作产品，除本手册规定的安全性预防措施外，还必须遵守公认的安全规程。

产品仅限经过培训的人员使用。

只有了解相关危险的合格人员才能进行开盖维修、保养或调整。

使用前，请务必检查产品是否来自已知来源，以确保正确操作。

本产品不适用于检测危险电压。

如果存在危险带电导体暴露，请使用个人保护装备以防电击和电弧爆炸伤害。

使用本产品时，您可能需要使用一套大型系统的其他部件。有关操作这类系统的警告和注意事项，请阅读其

他器件手册的安全性部分。

将本设备集成到某系统时，该系统的安全性由系统的组装者负责。

避免火灾或人身伤害

使用合适的电源线： 只能使用本产品专用并经所在国家/地区认证的电源线。不要使用为其他产品提供的电

源线。

将产品接地： 本产品通过电源线的接地导线接地。为避免电击，必须将接地导线与大地相连。在对本产品的

输入端或输出端进行连接之前，请务必将本产品正确接地。不要切断电源线的接地连接。

断开电源： 电源线可以使产品断开电源。请参阅有关位置的说明。请勿将设备放在难以操作电源线的位置；

必须保证用户可以随时操作电源线，以便需要时快速断开连接。

正确连接并正确断开连接： 探头或测试导线连接到电压源时请勿插拔。仅使用产品附带的或 Tektronix 指明适

合产品使用的绝缘电压探头、测试导线和适配器。

遵守所有终端额定值： 为避免火灾或电击危险，请遵守产品上的所有额定值和标记说明。在连接产品之前，

请先查看产品手册，了解额定值的详细信息。请勿超过产品、探头或附件中各器件中额定值最低者的测量类

别 (CAT) 额定值和电压或电流额定值。在使用 1:1 测试导线时要小心，因为探头端部电压会直接传输到产品

上。

对任何终端（包括公共终端）施加的电势不要超过该终端的最大额定值。

请勿将公共终端的电压浮动到该终端的额定电压以上。

本产品的测量端子额定值不适用于连接到市电或 II、III 或 IV 类型电路。

请勿开盖操作： 请勿在外盖或面板拆除或机壳打开的状态下操作本产品。可能有危险电压暴露。

远离外露电路： 电源接通后请勿接触外露的接头和器件。
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怀疑产品出现故障时，请勿进行操作： 如果怀疑本产品已损坏，请让合格的维修人员进行检查。

产品损坏时请勿使用。本产品损坏或运行错误时请勿使用。如果怀疑产品存在安全问题，请关闭产品并断开

电源线。在产品上做清晰标记以防其再被使用。

在使用之前，请检查电压探头、测试导线和附件是否有机械损坏，如损坏则予以更换。如果探头或测试导线

损坏、金属外露或出现磨损迹象，请勿使用。

在使用之前请先检查产品外表面。查看是否有裂纹或缺失部件。

仅使用规定的替换部件。

请勿在潮湿环境下操作： 请注意，如果某个单元从冷处移到暖处，则可能产生冷凝水。

请勿在易燃易爆的环境下操作：

请保持产品表面清洁干燥： 清洁本产品前，请移除输入信号。

请适当通风： 有关如何安装产品使其保持适当通风的详细信息，请参阅手册中的安装说明。

所提供的狭槽和开口用于通风，不得遮盖或阻挡。请勿将物体放进任何开口。

提供安全的工作环境： 始终将产品放在方便查看显示器和指示器的地方。

避免对键盘、指针和按钮盘使用不当或长时间使用。键盘或指针使用不当或长时间使用可能导致严重损伤。

请确保工作区符合适用的人体工程学标准。请咨询人体工程学专家，以避免应激损伤。

抬起或搬运产品时请小心谨慎。本产品带有便于抬起和搬运的手柄。

警告： 本产品较重。为了降低人身伤害或设备损坏的风险，在抬起或搬运产品时请寻求帮助。

仅限使用为本产品指定的泰克机架安装硬件。

探头和测试导线

连接探头或测试导线之前，请将电源线从电源连接器连接到正确接地的电源插座。

请将手指放在探头上保护屏障、手指防护装置或触觉指示器的后面。

拔掉所有不用的探头、测试导线和附件。

仅使用正确的测量类别 (CAT)、电压、温度、海拔高度和电流额定的探头、测试导线和适配器进行测量。

小心高电压： 了解您正在使用的探头的额定电压，请不要超出这些额定值。重要的是知道并理解两个额定

值：

■ 探头端部到探头参考导线的最大测量电压

■ 探头参考导线到大地的最大浮动电压

这两个额定电压取决于探头和您的应用。请参阅手册的“技术规格”部分了解更多详情。

警告： 为防止电击，请不要超出示波器输入 BNC 连接器、探头端部或探头参考导线的最大测量电压或最大
浮动电压。

重要安全信息  
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正确连接并正确断开连接： 将探头连接到被测电路之前，先将探头输出端连接到测量产品。在连接探头输入

端之前，请先将探头参考导线与被测电路连接。将探头与测量产品断开之前，请先将探头输入端及探头参考

导线与被测电路断开。

只能将探头参考导线连接到大地。

检查探头和附件： 在每次使用之前，请检查探头和附件是否损坏（探头本体、附件、电缆外壳等的割裂、破

损、缺陷）。如果损坏，请勿使用。

使用以地为参考的示波器： 在使用以地为参考的示波器时，不要将此探头的参考引线浮地。参考引线必须连

接到大地电势 (0 V)。

浮动测量使用： 不要将此探头的参考引线浮动到额定浮动电压之上。

维修安全概要

维修安全概要部分包含安全执行维修所需的其他信息。只有合格人员才能执行维修程序。在执行任何维修
程序之前，请阅读此维修安全概要和常规安全概要。

避免电击： 接通电源时，请勿触摸外露的连接。

请勿单独进行维修： 除非现场有他人可以提供急救和复苏措施，否则请勿对本产品进行内部维修或调整。

断开电源： 为避免电击，请先关闭仪器电源并断开与市电电源的电源线，然后再拆下外盖或面板，或者打开

机壳以进行维修。

带电维修时要小心操作： 本产品中可能存在危险电压或电流。在卸下保护面板，进行焊接或更换元件之前，

请先断开电源，卸下电池（如适用）并断开测试导线。

维修后验证安全性： 请务必在维修后重新检查接地连续性和市电介电强度。

手册中的术语

本手册中可能出现这些术语：

警告： “警告”声明指出可能会造成人身伤害或危及生命安全的情况或操作。

注意： “注意”声明指出可能对本产品或其他财产造成损坏的情况或操作。

 重要安全信息
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产品上的术语

产品上可能出现这些术语：

■ DANGER（危险）表示您看到该标记时可直接导致人身伤害的危险。

■ WARNING（警告）表示您看到该标记时不会直接导致人身伤害的危险。

■ CAUTION（注意）表示可能会对本产品或其他财产带来的危险。

产品上的符号

产品上标示此符号时，请确保查阅手册，以了解潜在危险的类别以及避免这些危险需采取的措施。

（此符号还可能用于指引用户参阅手册中的额定值信息。）

产品上可能出现以下符号：

重要安全信息  
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前言

本手册提供产品安全和一致性信息，说明示波器连接和通电方法并介绍仪器功能、控件和基本操作。有关更

多详细信息，请参阅产品 Help（帮助）文件。

主要功能

欢迎使用 5 系列紧凑型 MSO。5 系列紧凑型 MSO (MSO58LP) 是一款 8 通道示波器，在世界上首先采用了基于

FlexChannel® 的输入，让您可以针对几乎所有设计高效经济地执行混合信号调试。

■ 不带显示器的紧凑型仪器随时可安装在 2U 机架空间

■ 1 GHz、500 MHz（可升级） 带宽

■ 8 条通道，采用 FlexChannel® 输入

■ 各 FlexChannel 输入具有两种功能，供您连接模拟探头（TekVPI® 或 BNC）或 8 通道数字探头（TLP058 
FlexChannel 逻辑探头）

■ 最高 6.25 GS/s 采样率

■ 所有通道上的记录长度均为 125 M 点

■ 最大波形捕获速率 500,000 个波形/秒

■ FastFrame™ 分段内存采集使用多个触发事件，以高采样率捕获广发有趣事件并节约采集内存

■ 对可采集的数学波形、参考和总线的数量没有设置限制（波形数量取决于可用的系统内存）

■ 集成选件包括 50 MHz 任意函数发生器 (AFG) 以及数字电压表 (DVM) 和触发频率计数器

■ 高级串行总线触发和分析选项确保您能够在行业标准总线上执行解码和触发操作。请参阅串行总线和触
发选项 Help（帮助）主题

■ 功率和抖动选项提供额外的测量和分析功能。请参阅高级功率分析和高级抖动分析选项 Help（帮助）主
题

MSO58LP 安装和安全手册 vii



相关文档

请使用相关文档了解仪器功能的更多信息、如何远程编程或操作仪器、了解工作原理、更换可能出现故障的
模块以及执行其他任务。

MSO58LP 文档

需了解的信息 使用此文档

如何使用仪器功能 5 系列 MSO MSO58LP 安装和安全手册（本文档，泰克部件编号 071-3568-xx）；仪器

标配附件。包含英文、日文和简体中文语言的单个文档。俄语版本可以从泰克网
站下载（泰克部件编号 077-1404-xx）
5 系列和 6 系列 MSO 帮助（泰克部件编号 077-1303-xx；仪器 Help（帮助）的可打

印版本；可从 www.tektronix.com/downloads 获取）

如何远程控制仪器 5 系列和 6 系列 MSO 程序员手册（泰克部件编号 077-1305-xx；可从 www.tek.com/
downloads 获取）

仪器技术规格以及验证仪
器是否符合技术规格的流
程

5 系列 MSO MSO54、MSO56、MSO58、MSO58LP 技术规格和性能验证技术参考（泰

克部件编号 077-1306-xx；可从 www.tek.com/downloads 获取）

使用 TLP058 逻辑探头 TLP058 FlexChannel® 逻辑探头说明（泰克部件编号 071-3515-xx；可从 www.tek.com/
downloads 获取）

转换仪器以便在工作台上
使用

MSO58LP 工作台转换套件说明（泰克部件编号 075-1102-xx；可从 www.tek.com/
downloads 获取）

前言  
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安装仪器

检查附带的附件

确保您已收到所有订购物品。如果有任何缺失，请联系泰克客户支持。在北美地区，请拨打 1-800-833-9200。
其他地区用户请访问 www.tek.com 查找当地的联系信息。

请核对仪器随附的包装清单，以确认是否收到所有标配附件和订购物品。如果您购买了出厂安装的选件（如

串行总线和触发选件或功率测量选件），请点击 Help（帮助）> About（关于）以确认选件已在 Installed Options
（已安装选件）表中列出。

MSO58LP 标配附件

项目 数量 泰克部件编号

5 系列 MSO MSO58LP 安装和安全手册 1 071-3568-xx

电源线 1 取决于区域

校准证书 1 不适用

出厂安装许可的报告 1 不适用

操作要求

请根据操作温度、电源、海拔高度和信号输入电压范围要求使用示波器，以提供最准确的测量并确保仪器操

作安全。

环境要求

特性 说明

工作温度 0℃ 至 +50℃（+32℉ 至 +122℉）

为确保正常散热，请不要在仪器两侧 2 英寸（51 毫米）范围内堆放物

品。

工作湿度 在不高于 +40 °C (+104 °F) 时，相对湿度为 5% 到 90% (% RH)，无冷凝。

在 +40℃ 至 +50℃（+104 °F 至 +122℉）时，相对湿度为 5% 至 55%，无冷

凝。

工作海拔高度 最高 3,000 米（9,842 英尺）
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电源要求

特性 说明

电源电压 100 V - 240 VAC RMS，±10%，单相

电源频率 50/60 Hz，100-240 V
400 Hz，115 V

功耗 所有型号：最高 400 W

输入信号要求

将输入信号控制在允许的限制范围内，以确保最精确的测量并防止损坏模拟或数字探头或仪器。

确保输入信号满足以下要求。

输入 说明

模拟输入通道，1 M Ω 设置，BNC 提供最大

输入电压

300 VRMS
测量类别 II

模拟输入通道，50 Ω 设置，BNC 提供最大

输入电压

5 VRMS

数字输入通道，数字输入提供最大输入电

压

遵照探头额定值
TLP058；±42 VP

Ref In BNC 提供最大输入电压（后面板） 7 VPP

辅助触发输入 ±5 VRMS

在机架中安装仪器

使用这些仪器在标准 19" 设备机架中安装 MSO58LP。

MSO58LP 配有装在底盘上的机架托架五金件。使用仪器随附包中的螺栓和垫圈将后机架支架安装到机架中。

要在工作台上使用 MSO58LP，请购买并安装 MSO58LP 工作台转换包（泰克部件编号 020-3180-xx）。此包装有

底盘支脚和把手，供您将仪器叠放在工作台上。

请按照以下步骤在机架中安装仪器：

安装仪器  
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警告： 为了防止受伤，需要两人安装仪器。

1. 使用附带五金件中的两颗螺栓和垫片将一个后机架托架装在机架后部。用手拧紧。
 

 

2. 由两人扶住仪器，从机架前部插入仪器，使底盘机架托架插入后机架托架中。

3. 继续从前部推入，直至仪器与机架的前部齐平。

4. 使用附带五金件中的四颗螺栓和垫片将仪器前部装在机架后部。用手拧紧以支撑仪器。

5. 从机架后部，将第二个后机架托架滑到仪器底盘机架托架上，直至后机架托架与后机架齐平。

6. 使用附带五金件中的两颗螺栓和垫片将第二个后机架托架装在机架后部。用手拧紧。

7. 将所有螺栓拧至 1.1 N·m。

8. 使用 5/16 英寸扳手将附带的两颗六角螺栓装在每侧的后机架上，以便锁紧机架并防止在拆下前机架螺钉

后无意拆下仪器（见下图）。每侧共有四个螺栓位置（如图所示）。将托架锁紧螺栓拧至 0.7 N·m。
 

 

9. 根据需要，将电源线和电缆连接后底盘。

机架安装说明结束。
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确保示波器安全（将其锁定）

将示波器锁定到测试工作台或设备机架以防止造成财产损失。

将标准笔记本电脑安全锁定到示波器后面板，以便将示波器固定到工作台机架或其他位置。
 

 

接通示波器电源

使用此步骤将示波器连接到市电电源，然后打开和关闭示波器。请始终使用仪器附带的电源线将示波器连接

到交流电源。

前提条件：使用示波器附带的交流电源线。

1. 将附带的电源线连接到示波器电源连接器。

图 1: MSO58LP 电源线连接器和电源待机开关

2. 将电源线连接到合适的市电电源。

每当将交流电源线连接到市电供电电路并将仪器置于待机模式时，将会为电源和其他一些电路板供电。

3. 按下前面板电源按钮来打开和关闭仪器电源。

电源按钮颜色指示仪器电源状态：

不亮 – 未提供交流电源

黄色 – 待机模式

蓝色 – 已通电

4. 要从仪器上完全断开电源，请断开电源线。
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确认示波器通过开机自检

开机自检将确认所有示波器模块在开机后是否正常工作。

前提条件：对于 MSO58LP，将显示器连接到后面板的视频输出端口并将鼠标连接至 USB 端口。

1. 接通示波器电源，然后等待，直至出现示波器屏幕。

2. 从顶部菜单栏中选择 Utility（辅助功能）> Self Test（自检）来打开 Self Test（自检）配置菜单。

3. 确认所有开机自检的状态均为 Passed（通过）。

如果一次或多次开机自检均显示 Failed（失败）：

a. 重新接通示波器电源。

b. 点击 Utility（辅助功能）> Self Test（自检）。如果一次或多次开机自检仍显示 Failed（失败），请联系

泰克客户支持。

连接探头

探头和电缆将示波器连接到您的被测设备 (DUT)。使用能够最好匹配您的信号测量要求的探头。

图 2: 将探头连接 MSO58LP

将 TPP0500B、TPP1000、TekVPI+、TekVPI 或其他支持的泰克模拟探头推入 FlexChannel 连接器将其连接。探头

完全到位后将会听到“咔”的声音，探头闭锁即被锁定。

TekVPI 探头自动设置该探头的通道输入参数（带宽、衰减、端接等）。如果探头包含 Menu（菜单）按钮，按

下该按钮可打开屏幕上配置菜单。请按照有源探头提供的说明设置参数（自动调零、消磁等）。

 安装仪器
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连接 TLP058 FlexChannel 逻辑探头或 TDP7700 系列 TriMode™ 探头：

1. 将锁定杆移动到未锁定位置，然后释放以将锁定杆重置到中心位置。

2. 将探头插入 FlexChannel 连接器，直到完全到位并听到锁定机制发出“咔”的声音。

3. 将锁定杆移动到锁定位置。状态灯应呈恒绿色。

4. 要断开 TLP058 探头，请将锁定杆移动到未锁定位置并按住，然后拉出探头。取下探头时不要拉扯排线。

将 BNC 探头或电缆推入通道 BNC 卡口连接器将其连接，然后顺时针旋转锁定机制直至锁定。

注意： 连接探头时不会自动启用（激活）该通道。使用仪器控件或编程接口启用通道并打开其配置菜单以确
认或更改探头或电缆设置（带宽、衰减、端接等）。
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熟悉仪器

MSO58LP 前面板控件和连接器

前面板用于接通或断开仪器电源、向探头或电缆传送信号、连接外部触发输出信号、插入 USB 设备和访问探

头补偿信号。
 

 

1. FlexChannel® 探头连接器：

FlexChannel® 连接器支持所有 TekVPI+ 和 TekVPI 测量探头、BNC 无源探头、TLP058 FlexChannel® 逻辑探头和

BNC 电缆。连接大多数探头时，只需将其推入连接器直到完全到位并听到“咔”的声音。请参阅 连接探
头第 5 页

2. LAN 状态 LED：

显示网络连接和活动状态：

■ 不亮 - 仪器未通电

■ 绿色 - 网络连接正常

■ 红色 - 网络连接出现故障或未连接
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3. 探头补偿连接器：
 

 

探头补偿连接提供了一个接地连接器和 1kHz 方形波源，可用于调节无源探头的高频率响应（探头补偿）。

示波器使用该信号自动补偿支持的探头。请参阅 补偿 TPP0500B 或 TPP1000 探头第13 页。

您也可以使用接地连接器连接防静电手环，在搬运或探测 DUT 时，减少静电损坏 (ESD) 的机会。

4. USB 主控端口：

USB 端口位于前面板右下角上。连接可保存或调出数据（如仪器固件更新、波形、设置和屏幕捕获）的

U 盘，或连接鼠标或键盘等外围设备。

5. Aux Trig 触发输入连接器：

用于连接外部触发输入信号的 SMA 连接器。配合使用 AUX In 触发信号与 Edge（边沿）触发模式。

6. 采集状态 LED：

显示仪器触发/采集状态：

■ 绿色 - 触发

■ 黄色 - 启动未触发

■ 红色 - 采集停止

7. Power On/Standby（开机/待机）按钮：

接通和断开仪器电源。电源按钮颜色指示仪器电源状态：

■ 不亮 – 未提供交流电源

■ 黄色 – 待机模式

■ 蓝色 – 已通电

熟悉仪器  

8 MSO58LP 安装和安全手册



后面板连接

后面板连接可为示波器供电并提供网络、USB 设备、视频、参考信号和 AFG 输出的连接器。
 

 

1. 电源线连接器。只能使用本产品专用并经所在国家/地区认证的电源线。

2. Ref In 用于将高精度 10MHz 参考信号连接到示波器，以提高测量准确度。

3. AUX Out 可对触发事件生成跳变，输出 10 MHz 参考信号或从 AFG 输出同步信号。

4. AFG Out 是选配任意函数发生器 (AFG) 的信号输出。

5. 视频输出（显示端口、VGA 和 DVI-D）用于连接外部监视器或投影仪来显示示波器屏幕。

6. USB 设备端口用于连接到一台 PC，以使用 USBTMC 协议远程控制示波器。

7. USB 主控端口用于连接 USB 内存设备、键盘或鼠标。

8. LAN 连接器 (RJ-45) 将示波器连接到 10/100/1000 Base-T 局域网。

9. 安全锁连接器用于使用标配 PC/笔记本电脑锁电缆将示波器固定到工作台或其他位置。

图形用户界面

尽管专为编程控制设计，MSO58LP 的图形用户界面同样包括产品帮助主题。您可以通过以下方法访问图形界

面：将显示器和鼠标连接仪器或使用浏览器访问联网仪器。

将分辨率至少为 1,920 水平像素 × 1,080 垂直像素（高清）的显示器（标准或触摸屏）连接后面板上的视频输

出连接器。

要从浏览器访问，请在浏览器地址栏中输入仪器的 IP 地址，以打开仪器的浏览器欢迎页面。单击屏幕左侧的

仪器控制（仪器控制）(e*Scope®) 链接打开图形界面。

将鼠标（USB 线）或鼠标加密狗（供 USB 无线鼠标使用）连接任一 USB 端口。

有关理解和使用图形用户界面的详情，请参阅 5 系列 MSO（MSO54、MSO56、MSO58）安装和安全手册（泰克

部件编号 071-3514-xx；可以从 www.tek.com/product-support 下载。）

 熟悉仪器
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配置仪器

设置时区和时钟读数格式

将时区设置为您所在区域，以便为已保存的文件标记正确的日期和时间信息。您还可以设置时间格式（12 或
24 小时制）。

要在 MSO58LP 上访问用户界面，请将显示器连接仪器后部的视频端口并将鼠标连接任一 USB 主控端口。如

果远程显示器支持触摸操作，则无需连接鼠标。您也可以在 web 浏览器中输入仪器的 IP 地址来远程访问联网

仪器的用户界面。

要远程设置此控件或在 MSO58LP 上执行此任务，请参阅示波器程序员手册（泰克部件编号为 077-1305-xx）了

解需使用的正确命令。

1. 双击 Date/Time（日期/时间）标记（屏幕右下方）打开配置菜单。
 

 

2. 要关闭在屏幕上显示日期和时间，请将 Display（显示）按钮点按为 Off（关）。

要再次打开日期/时间显示，请双击显示日期/时间标记所在的空白区域打开配置菜单，然后，将 Display
（显示）按钮设置为 On（开）。

3. 选择时间格式（12 Hour（12 小时制）或 24 Hour（24 小时制））。

4. 点击 Time Zone（时区）字段并选择适用您所在位置的时区。

5. 点击菜单外任何地方将其关闭。

下载并安装最新固件

安装最新固件将有助于确保示波器测量的最大精确度。

要在 MSO58LP 上访问用户界面，请将显示器连接仪器后部的视频端口并将鼠标连接任一 USB 主控端口。如

果远程显示器支持触摸操作，则无需连接鼠标。您也可以在 web 浏览器中输入仪器的 IP 地址来远程访问联网

仪器的用户界面。
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从 U 盘更新示波器固件

前提条件：确定示波器上已安装的当前固件版本（Help（帮助）> About（关于））

1. 打开 PC 中的 Web 浏览器并访问 www.tek.com/product-support。

2. 在搜索字段中输入示波器型号并单击 Go（前往）。

3. 向下滚动屏幕并单击 Software（软件）选项卡。

4. 如果列出的可用固件版本（Windows 或非 Windows 版本）高于示波器中的版本，请选择此文件并下载到您的

PC 中。

5. 请按照已下载固件随附的安装说明创建固件安装文件。

6. 将固件安装文件复制到 U 盘。

7. 将 U 盘插入任一示波器 USB 主控端口：

a. 非 Windows 示波器将检测到含固件文件的 U 盘并开始安装过程。按照屏幕说明安装固件。

b. 对于 Windows 示波器，在更新固件前，请关闭 TekScope 程序。打开 File Explorer（资源管理器）并运行

U 盘中的固件更新文件，或者，将固件更新文件复制到桌面并从桌面运行此文件。按照屏幕说明安

装固件。

注意： 在示波器完成固件安装之前，请勿关闭示波器电源或移除 U 盘。示波器将在可以关闭示波器时显
示一条消息。

8. 完成固件安装后，请移除 U 盘并重启示波器。

要确认固件安装，请执行以下操作：

a. 在 Menu（菜单）栏中点击 Help（帮助）> About（关于）。

b. 请确认屏幕上列出的固件版本号与已下载的版本相同。

运行信号路径补偿 (SPC)
以常规间隔运行 SPC，以获得最佳测量精度。每当环境（室内）温度改变超过 5℃（9℉）时都应执行 SPC，
如果使用 5 mV/格或更低的垂直刻度设置，则应每周执行一次 SPC。

要在 MSO58LP 上访问用户界面，请将显示器连接仪器后部的视频端口并将鼠标连接任一 USB 主控端口。如

果远程显示器支持触摸操作，则无需连接鼠标。您也可以在 web 浏览器中输入仪器的 IP 地址来远程访问联网

仪器的用户界面。

要远程设置此控件或在 MSO58LP 上执行此任务，请参阅示波器程序员手册（泰克部件编号为 077-1305-xx）了

解需使用的正确命令。

信号路径补偿 (SPC) 可修正由于温度变化和/或长期信号路径漂移引起的内部信号路径的直流电平误差。如

果无法以常规间隔运行 SPC，可能导致示波器不能达到低伏/格设置时所保证的性能水平。

前提条件：从前面板通道输入和后面板信号连接器断开所有探头和电缆。

1. 打开示波器电源并预热至少 20 分钟。

2. 点击 Utility（辅助功能）> Calibration（校准）。

配置仪器  
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3. 点击 Run SPC（运行 SPC）。SPC 运行时 SPC Status（SPC 状态）读数显示 Running（正在运行）。SPC 在
每个通道需要数分钟的运行时间，因此请等待直到 SPC Status（SPC 状态）消息更改为 Pass（通过）才能

重新连接探头和使用示波器。

注意： 您可以通过点击 Abort SPC（终止 SPC）来终止 SPC 校准。这可能导致某些通道未被补偿，从而
可能造成测量结果不准确。如果终止 SPC，请确认运行完 SPC 步骤才能使用该仪器进行测量。

4. 请在完成 SPC 时关闭 Calibration（校准）配置对话框。

5. 如果 SPC 失败，请记下所有错误消息文字内容。确认已断开所有探头和电缆，然后重新运行 SPC。如果

SPC 仍然失败，请联系泰克客户支持。

补偿 TPP0500B 或 TPP1000 探头

探头补偿将调整探头的高频率响应，以获得最佳波形捕获和测量精度。示波器可为无限数量的探头/通道组合

自动测试和存储补偿值。

要在 MSO58LP 上访问用户界面，请将显示器连接仪器后部的视频端口并将鼠标连接任一 USB 主控端口。如

果远程显示器支持触摸操作，则无需连接鼠标。您也可以在 web 浏览器中输入仪器的 IP 地址来远程访问联网

仪器的用户界面。

要远程设置此控件或在 MSO58LP 上执行此任务，请参阅示波器程序员手册（泰克部件编号为 077-1305-xx）了

解需使用的正确命令。

示波器可存储每个探头/通道组合的补偿值，并在插入探头时自动调出补偿值。探头补偿状态将显示在

Channel（通道）配置菜单的 Probe Setup（探头设置）面板中。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Pass（通过），则探头已被补偿并可以使用。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Default（默认），则所连接的探头不会得到补偿

并需要运行该探头补偿程序。

■ 如果 Probe Compensation Status（探头补偿状态）字段显示 Fail（失败），则对所连接的探头运行探头补偿

程序失败。重新连接探头并再次运行探头补偿。

■ 如果面板中未显示探头补偿状态字段，则示波器无法存储该探头的补偿值。请参阅示波器 Help（帮助）

以了解如何手动补偿探头补偿功能不支持的无源探头。

使用此步骤补偿连接到示波器时显示 Default（默认）状态的 TPP0500B、TPP1000 或其他支持的 TPP 系列探

头。

注意： Default Setup（默认设置）不会删除探头补偿值。出厂校准将删除存储的所有探头补偿值。
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前提条件：示波器必须通电至少 20 分钟以上才能补偿探头。

1. 将支持的探头连接到输入通道。

2. 将探头端部和探头的接地导线连接示波器右下方的探头补偿终端（如下图所示）。

图 3: MSO58LP 上探头补偿连接器。

将探头端部连接 1kHz 信号源并将接地夹接地。为获得最佳效果，请取下所有探头端部附件并将探头端部

直接连接 1kHz 连接器。

注意： 每次仅将一个探头连接到探头补偿终端上。

3. 关闭所有通道。

4. 打开与探头连接的通道。

5. 在 MSO58LP 上，从菜单栏中选择 File（文件）> Autoset（自动设置）。屏幕显示一个方波。

6. 双击要补偿的通道的标记。

7. 点击 Probe Setup（探头设置）面板。

如果 Probe Compensation Status（探头补偿状态）显示 Pass（通过），则探头已补偿该通道。您可以将探头

移动到另一个通道并从第 1 步重新开始操作，或者将不同的探头连接到该通道并从第 1 步开始操作。

如果 Probe Compensation Status（探头补偿状态）显示 Default（默认），请继续该步骤。

8. 点击 Compensate Probe（补偿探头）打开 Probe Compensation（探头补偿）对话框。

9. 点击 Compensate Probe（补偿探头）运行探头补偿。

10. 当 Probe Compensation Status（探头补偿状态）显示 Pass（通过）时，探头补偿将完成。从 Probe Comp（探

头补偿）终端拔下探头端部和地线。

11. 为要补偿该通道的所有支持的无源探头重复这些步骤。

12. 重复这些步骤补偿示波器其他通道所支持的探头。

注意： 为获得最准确的测量，每当将探头连接到通道时，请打开 Probe Setup（探头设置）面板并验证
Probe Compensation Status（探头补偿状态）为 Pass（通过）。

配置仪器  

14 MSO58LP 安装和安全手册



连接网络 (LAN)
连接网络可以远程访问仪器。

要在 MSO58LP 上访问用户界面，请将显示器连接仪器后部的视频端口并将鼠标连接任一 USB 主控端口。如

果远程显示器支持触摸操作，则无需连接鼠标。您也可以在 web 浏览器中输入仪器的 IP 地址来远程访问联网

仪器的用户界面。

向您的网络管理员获取所需的信息以连接到网络（IP 地址、网关 IP 地址、子网掩码、DNS IP 地址等）。

1. 将示波器 LAN 连接器的 CAT5 电缆连接到您的网络。

2. 在菜单栏上选择 Utility（辅助功能）> I/O 来打开 I/O 配置菜单。

3. 获取或输入网络地址信息：

■ 如果网络已经启用 DHCP 且 IP 地址字段未显示地址，请点击 Auto（自动）获取此网络的 IP 地址信

息。DHCP 模式为默认模式。

■ 如果网络未启用 DHCP 或者您需要为该仪器设置永久（不变）的 IP 地址，请点击 Manual（手动）并输入

IT 或系统管理员提供的 IP 地址及其他值。

4. 点击 Test Connection（测试连接）以验证该网络连接正常工作。仪器成功连接网络后，LAN 状态图标将变

为绿色。如果在连接网络时遇到问题，请联系系统管理员以获取帮助。

MSO58LP 上的前面板 LAN 状态 LED 颜色显示网络状态：

■ 不亮 - 仪器未通电

■ 绿色 - 网络连接正常

■ 红色 - 网络连接出现故障或未连接

从 Web 浏览器远程访问

您可以从 Web 浏览器远程访问联网的标准仪器（未运行 Windows 10）以便在 PC 上显示仪器用户界面。

此过程介绍如何远程访问标准仪器（非 Windows 10）的 UI 控件和屏幕。要远程访问 Windows 10 仪器的 UI 控件

和屏幕，请参阅

前提条件：

■ 示波器必须连接到 PC 所连接的网络并通过该网络进行访问。请参阅 连接网络 (LAN)第 15 页

■ 您要访问的示波器的 IP 地址。要确定示波器的 IP 地址，请在示波器菜单栏中选择 Utility（辅助功能）>
IO，然后在 LAN 面板中查看网络设置。

■ 您正在访问标准仪器（未安装 Windows 操作系统选件）。

1. 在与示波器连接同一网络的 PC 中打开网络浏览器。

2. 只需在浏览器的 URL 行输入示波器 IP 地址，并按下 Enter（回车）。例如：135.62.88.157。浏览器将搜索并

打开示波器的网页。

 配置仪器
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3. 选择 Instrument Control（仪器控制）(e*Scope®)。浏览器显示仪器屏幕。

4. 使用鼠标选择网络浏览器中显示的示波器控件并与其互动。如果您的远程 PC 或笔记本电脑配有触摸屏

显示器，您可以使用它访问示波器控件。

注意： 使用 e*Scope 浏览器访问仪器时，无法直接从 PC 向仪器菜单字段中粘贴文字（例如路径、IP 地址
信息等）。必须使用 e*Scope 应用中提供的中间剪贴板功能。

使用以下几步从连接 e*Scope 的 PC 向仪器中复制文字：

a. 打开与使用 e*Scope 的仪器的连接。

b. 在 PC 上选择并复制文字。

c. 在 e*Scope 中，按 Ctrl-Alt-Shift 打开 Clipboard（剪贴板）菜单。

d. 将文字粘贴到剪贴板字段中。

e. 按 Ctrl-Alt-Shift 关闭浏览器 Clipboard（剪贴板）菜单

f. 使用 e*Scope 打开要粘贴内容的仪器菜单，然后，将光标放在要粘贴文字的字段中。

g. 按 Ctrl-V（真正键盘或虚拟键盘）从 e*Scope 浏览器剪贴板向菜单字段中粘贴文字。

h. 重复第  4.b 步至第  4.g 步以便从 PC 向仪器中复制和粘贴其他文字。

配置仪器  
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操作基础

有关理解和使用图形用户界面来触发和获取波形并进行测量的详情，请参阅 5 系列 MSO（MSO54、MSO56、
MSO58）安装和安全手册（泰克部件编号 071-3514-xx）。

有关正确操作仪器所用的正确命令，请参阅 5 系列 MSO MSO54、MSO56、MSO58、MSO58LP 程序员手册（泰

克部件编号为 077-1305-xx）。

这两本手册均可从 www.tek.com/product-support 下载。

MSO58LP 安装和安全手册 17
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维护

本部分包含对仪器进行定期维护所需的信息。

注意： 除非要更换损坏的顶盖，否则请勿从仪器上卸下顶盖。仪器内部没有可由用户更换的部件。将仪器返
回泰克进行维修（如果需要维修）。

清洁

使用柔软的干棉布清洁设备外部。如果仍有任何污垢，请用软布或棉签蘸 75% 的异丙基酒精溶液清洁。使用

棉签清洁控件和连接器周围的狭小空间。请勿使用任何可能损坏、外壳、控件、标记或标签或者可能渗入外
壳的液体清洁剂或化学品。

性能验证间隔和调整

仪器内的电压基准和定时基准非常稳定，无需定期调整。

如果定期校准是贵组织的要求之一，则一般规则是每操作 2000 个小时验证一次性能，如果仪器不经常使用，

则每年执行一次。请使用仪器的《规格和性能验证手册》（可从 www.www.tek.com/product-support 在线获取）中

所述的步骤。

如果仪器未通过《技术规格和性能验证》手册中的性能测试，则可能需要进行调整。只应由泰克维修中心执

行调整。有关泰克维修中心的联系信息，请参阅本手册标题页面后的“泰克联系信息”。

可替换部件列表

本部分包含仪器的可更换部件信息。使用相应部分中的列表，确定和订购仪器的可更换部件。

标配附件

本手册开头附近部分列出了这些产品的标配附件。

可更换部件

下图显示了 MSO58LP 中可由用户更换的部件。仪器内部没有可由用户更换的部件。

MSO58LP 安装和安全手册 19



图 4: 可替换部件图

维护  
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表 1: 可替换部件列表

索引号 泰克部件编号 数量 名称和说明

1 407-6088-xx 2 支架，前部，机架安装，2U EAR
2 211-1682-xx 14 螺钉，10-32 X 5/16 钮头，帽，黑色

3 407-6089-xx 2 支架，后部，机架安装，底盘侧

4 407-6090-xx 2 支架，后座，机架安装，机架侧

5 020-3180-xx 1 台式转换套件（可选附件）

未显示：

A0 1 北美电源插头（115 V，60 Hz）
A1 1 欧洲通用电源插头（220 V，50 Hz）
A2 1 英国电源插头（240 V，50 Hz）
A3 1 澳大利亚电源插头（240 V，50 Hz）
A5 1 瑞士电源插头（220 V，50 Hz）
A6 1 日本电源插头 (100 V, 50/60 Hz)
A10 1 中国电源插头 (50 Hz)
A11 1 印度电源插头 (50 Hz)
A12 1 巴西电源插头 (60 Hz)

 维护
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EMC、安全和环境合规性

合规性信息

此部分列出仪器遵循的 EMC（电磁兼容性）、安全和环境标准。本产品仅供专业人员和受过培训的人员使用；

不得在家中或供儿童使用。

如果对以下合规性信息存在疑问，可以联系以下地址：

Tektronix, Inc.

PO Box 500, MS 19-045

Beaverton, OR 97077, USA

www.tek.com

EMC 合规性

EU EMC 指令

符合 Directive 2014/30/EU 有关电磁兼容性的要求。已证明符合《欧洲共同体公报》中所列的以下技术规格：

EN 61326-1、EN 61326-2-1. 测量、控制和实验室用电气设备的 EMC 要求。  1 2 3 4

■ CISPR 11。放射和传导辐射量，组 1，A 类

■ IEC 61000-4-2。对静电放电的抗干扰能力

■ IEC 61000-4-3。对射频电磁场的抗干扰能力  5

■ IEC 61000-4-4。对电快速瞬态/突发性的抗干扰能力

■ IEC 61000-4-5。对电源线电涌的抗干扰能力

■ IEC 61000-4-6。对传导射频的抗干扰能力

■ IEC 61000-4-11。对电压骤降和中断的抗干扰能力

EN 61000-3-2. 交流电源线谐波辐射

EN 61000-3-3. 电压变化、波动和闪变

1 本产品仅在非居民区内使用。在居民区内使用可能造成电磁干扰。
2 当该设备与测试对象连接时，可能产生超过此标准要求的辐射级别。
3 测试导线和/或测试探头由于电子干扰耦合而发生连接时，设备可能无法满足所列适用标准的抗干扰能力要求。为了将电磁干扰的影响降到最

低，需最小化信号无屏蔽部分与关联返回导线之间的环路面积，同时尽量让导线远离电磁干扰源。将未屏蔽的测试导线缠绕在一起是减小环

路面积的有效方法。探头方面，需要使接地回路导线的长度尽可能得短，并靠近探头主体。为了最有效地达到这一目的，一些探头配备了附

件探头端部适配器。在一切情况下，都应遵守所用探头或导线的所有安全说明。
4 为确保符合上面列出的 EMC 标准，应使用在电缆护套和连接器外壳间包含低阻抗连接的高质量屏蔽接口电缆。
5 10 mV/格至 1 V/格：当仪器受到 IEC 61000-4-3 测试所定义的电磁场和信号的影响时，允许 <=0.1 格波形位移或峰-峰值噪声增加 <=0.2 格。
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EMC 合规性

随“技术规格”表中指明的产品使用时，符合 2014/30/EU 指令中有关电磁兼容性的要求。请参阅针对指出的

产品发布的 EMC 技术规格。随其他产品使用时，可能不符合该指令的要求。

澳大利亚/新西兰一致性声明 – EMC
根据 ACMA，符合《无线电通信法》有关 EMC 规定的以下标准：

■ EN 61326-1 和 EN 61326-2-1。放射和传导辐射量，组 1，A 类。

安全标准

本部分列出了产品遵循的安全标准及其他安全合规性信息。

欧盟一致性声明 - 低电压

经证明符合《欧盟官方公报》中所列的以下技术规格：

低电压指令 2014/35/EU。

■ EN 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ EN 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊

要求。

美国国家认可的测试实验室列表

■ UL 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ UL 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊

要求。

加拿大认证

■ CAN/CSA-C22.2 No. 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ CAN/CSA-C22.2 No. 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和

测量电路的特殊要求。

其他合规性

■ IEC 61010-1。 测量、控制和实验室用电气设备安全要求 – 第 1 部分：总体要求。

■ IEC 61010-2-030。 测量、控制和实验室用电气设备安全要求 – 第 2-030 部分：关于测试和测量电路的特殊

要求。

设备类型

测试和测量设备。

安全级别

I 级 - 接地产品。

EMC、安全和环境合规性  
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污染度说明

对产品周围和产品内部环境中可能出现的污染的一种量度。通常认为产品的内部环境与外部环境相同。产
品只应该在其规定环境中使用。

■ 污染度 1。无污染或仅发生干燥、非导电性污染。此类别产品通常予以封装、密封或被置于干净的房间

中。

■ 污染度 2。通常只发生干燥、非导电性污染。偶尔会发生由凝结引起的临时传导。典型的办公室/家庭环

境属于这种情况。只有当产品处于非使用状态时，才会发生临时凝结。

■ 污染度 3。导电性污染，或干燥、非导电性污染，由于凝结后者会变成导电性污染。此类场所为温度和

湿度不受控制的建有遮盖设施的场所。此类区域不受阳光、雨水或自然风的直接侵害。

■ 污染度 4。通过传导性的尘埃、雨水或雪产生永久性可导性的污染。户外场所通常属于这种情况。

污染度评级

污染度 2（如 IEC 61010-1 中定义）。注：仅适合在室内的干燥场所使用。

IP 额定值

IP20（如 IEC 60529 中定义）。

测量和过压类别说明

本产品上的测量端子可能适合测量以下一种或多种类别的市电电压（请参阅产品和手册中标示的具体额定

值）。

■ 测量类别 II。用于在与低电压安装直接相连的电路上执行的测量。

■ 测量类别 III。用于在建筑安装中执行的测量。

■ 测量类别 IV。用于在低电压安装电源处执行的测量。

NOTE. 仅市电电源电路具有过压类别额定值。仅测量电路具有测量类别额定值。产品中的其他电路不具有其
中任何一种额定值。

主线过压类别额定值

过压类别 II（如 IEC 61010-1 中的定义）

环境合规性

本部分提供有关产品对环境影响的信息。

有害物质限制

符合 RoHS2 指令 2011/65/EU。

产品报废处理

回收仪器或器件时，请遵守下面的规程：

设备回收. 生产本设备需要提取和使用自然资源。如果对本产品的报废处理不当，则该设备中包含的某些物

质可能会对环境或人体健康有害。为避免将有害物质释放到环境中，并减少对自然资源的使用，建议采用适

当的方法回收本产品，以确保大部分材料可以得到恰当的重复使用或回收。

 EMC、安全和环境合规性
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此符号表示该产品符合欧盟有关废旧电子和电气设备 (WEEE) 以及电池的 2012/19/EU 和 2006/66/
EC 号指令所规定的相关要求。有关回收选项的信息，请登录泰克网站 (www.tek.com/
productrecycling) 查看。

电池回收

本产品装有小型锂金属纽扣电池。如果电量用尽，请根据当地政府法规正确处理或回收此电池。

高氯酸盐材料. 此产品包含一个或多个 CR 型锂电池。按照加州规定，CR 锂电池被归类为高氯酸盐材料，需

要特殊处理。详情参阅 www.dtsc.ca.gov/hazardouswaste/perchlorate。

运输电池

本设备的小型纽扣锂原电池的锂金属含量不超过 1 g/电池，制造商已经表示此类电池满足联合国《试验和标

准手册》第 3 部分第 38.3 节中的适用要求。在采用任一运输方式重新运输产品前，请咨询承运公司确定哪些

锂电池运输要求适用于您的配置，包括重新包装和重新贴标

EMC、安全和环境合规性  
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A
ACQ 采集状态 LED, 7
AFG OUT（后面板）, 9
AUX OUT（后面板）, 9
Aux Trig 触发输入, 7
安全电缆锁, 9

B
标配附件, 1

D
DVI 视频输出（后面板）, 9
打开或关闭电源, 4
打开或关闭仪器, 4
电缆锁, 9
电源待机模式, 4
电源线, 19
电源线连接器（后面板）, 9
电源要求, 1, 2
断开仪器的交流电源, 4

E
e*Scope, 15

F
FlexChannel 输入通道, 7

G
工作

海拔高度范围, 1, 2
湿度范围, 1, 2
温度范围, 1, 2

工作功率要求, 1, 2
固件，如何更新, 11, 12

H
后面板

AFG Out, 9
AUX Out, 9
DVI 视频输出, 9
LAN 端口 (RJ-45), 9
USB 设备端口, 9
USB 主控端口, 9
VGA 视频输出, 9
安全电缆锁, 9
电缆锁, 9
电源线, 9
视频输出, 9
显示端口视频输出, 9
以太网端口 (RJ-45), 9

后面板连接, 9
环境要求, 1, 2

K
开机自检结果, 5
可更换部件, 19

L
LAN 端口（后面板）, 9
LAN 状态 LED, 7
LAN，连接到, 15
连接锁定电缆, 4
连接探头, 5
连接网络, 15

Q
前面板控件, 7

R
Ref In, 9
Ref In（后面板）, 9
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如何
补偿 TPP0500B、TPP1000 探头, 13
更新固件, 11, 12
检查开机自检结果, 5
连接探头, 5
连接网络, 15
设置时区, 11
设置时钟格式（12/24 小时制）, 11
下载和安装固件, 11, 12
远程访问示波器（从 Web）, 15
运行信号路径补偿 (SPC), 12

如何补偿 TPP0500B、TPP1000 探头, 13

S
SPC（信号路径补偿）, 12
设置

时区, 11
时钟格式（12/24 小时制）, 11

时区，如何设置, 11
时钟格式（12/24 小时制），如何设置, 11
视频输出（后面板）, 9
输入信号电平要求, 2
锁定到工作台或机架, 4

T
探头，连接, 5
探头补偿（TPP0500B、TPP1000）, 13
探头补偿连接器, 7

U
USB 设备端口（后面板）, 9
USB 主控端口（后面板）, 9

V
VGA 视频输出（后面板）, 9

W
网络，连接到, 15
维护

可更换部件, 19

X
显示端口视频输出（后面板）, 9
信号输入电平, 2

Y
要求

电源, 1, 2
海拔高度, 1, 2
环境, 1, 2
湿度, 1, 2
温度, 1, 2
信号输入, 2

以太网，连接到, 15
以太网端口（后面板）, 9
远程访问 (e*Scope), 15
远程访问（基于 Web）, 15
运行信号路径补偿, 12

Z
自动探头补偿（TPP0500B、TPP1000）, 13
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